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Chapter 1: Agent overview

This chapter explains the role of the Agent, the components that comprise the Agent, and how to
deploy the Agent.

l The role of the Agent, below

l Support Center, below

l Agent accounts, on page 15

l Agent connections to Data Centers, on page 15

l Agent deployment tasks, on page 17

The role of the Agent

The Agent is a software that you install and configure on client computers that require signed binaries.
You use the Agent to back up files on the client computers and to retrieve files that you previously
backed up.

Every Agent has an account in the Data Center. The account contains information about the Agent
configuration.

The Agent sends files to the Data Center for backup. To perform a backup, the Agent scans the hard
drives of the computer on which it resides for files that require backup. Next, the Agent contacts the
Data Center to initiate a backup session. The Agent prepares the files for backup and notifies the Data
Center if users have deleted previously backed-up files since the last backup session.

To retrieve or restore files, the Agent requests the files from the Data Center, then downloads or
restores the files to the client computer.

The Agent initiates communication with the Data Center. The Data Center cannot contact an Agent
independently.

IMPORTANT:
The Agent does not support multi-user environments. Although you can install the Agent on a
computer that hosts more than one user account, you can only associate one user account with
the Agent. Additionally, more than one user account on a computer that hosts the Agent can
cause problems during file retrieval and backups.

Support Center

Support Center is aWeb-basedmanagement application that technicians use tomanage Agent
configurations and accounts. You can use Support Center from any computer with a supported browser
and a network or Internet connection. For the list of supported browsers, refer to theMicro
Focus Connected Backup Requirements Matrix.
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Use Support Center to manage the following information:

l Technician accounts

l Communities and Agent accounts

l Agent settings

l Agent profile andWeb site settings

l Agent versions

l Agent rules

l Reports

Support Center interface

The Support Center interface consists of two panes.

The left pane displays a hierarchical tree that represents the organization of Agent accounts on your
Data Center (if you host your Data Center) and your communities.

The right pane displays information relevant to the node that you select in the left pane.

The following figure shows the Support Center interface.

Nodes

The following table describes themajor nodes and subnodes in the Support Center interface:
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Item Description

Top-level node Expand the top-level node to view the nodes and subnodes in the tree. The top-level
node uses the Data Center server name and is the top-level community.

Accounts Find and display information about the user accounts in your Data Center.

Technicians Create andmodify logon accounts for technicians who use Support Center.

Report
Templates

Create templates to generate reports that track account use and other statistics.

Reports Display report results after you use the Report Templates node to generate a report.

Legacy PC
Configurations

Use the Configuration Summary page to create, edit, and view version 7.x or earlier
PC Agent configurations.

Configurations Create, edit, and view Profile andWebsite settings, Mac Agent configurations and
version 8.0 or later PC Agent configurations.

Communities and subcommunities

You can create communities and subcommunities to organize accounts. A community appears as a
node below the top-level node. A subcommunity appears as a subnode below a community node.

The following figure shows Subcommunity 1 underCommunity 1.

Each community and subcommunity has its ownAccounts, Technicians, Configurations, Report
Templates, andReports nodes.

Technicians

Technicians include Data Center administrators, Information Technology individuals, Technical
Support individuals, and others who support your user community. To use Support Center to perform
administrative tasks, a technicianmust create a technician account. A technician can give the account
as many permissions as necessary, and can delegate different tasks to supporting personnel.

For more information, see Set up communities and accounts, on page 20.

Communities

A community is a group of accounts with a common element. You can create communities based on
department, office location, Agent configuration, or any category that helps youmanage your accounts
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efficiently.

For more information, see Set up communities and accounts, on page 20.

Agent configurations

An Agent configuration is a set of settings and features that you want to apply to one or more Agents.
You can create configurations tomeet enterprise needs such as a backup schedule, security, and
features. After you create an Agent configuration, users can go to the Account Management Website to
download an Agent Setup file that uses the configuration. The Agent Setup applies the configuration
settings when users employ it to install an Agent, recover an Agent account, or upgrade an Agent.
Alternatively, you can install the Agent Setup file on client computers.

For more information, see Create Agent configurations, on page 40.

Rules

The Agent uses rules to determine which files to back up. When you build an Agent configuration, you
must assign a rule set.

For more information, see Create Agent rule sets, on page 46.

Reports

You can use Support Center to create and run reports about the use and status of accounts. You can
run reports once or regularly. You can configure reports to include charts. You can save reports in XML
format.

For more information, see Agent history and reports, on page 110.

Inheritanceof Support Center objects

A Support Center object can be an Agent configuration, a report template, or a technician account. The
inheritance feature lets you use top-level objects in all subcommunities. In other words, when you
create objects in a community, the objects apply to the community and its subcommunities.

Support Center displays inherited objects in the left pane in regular text. It displays objects that you
create in the community in bold text. You cannot edit the inherited objects. However, you can edit the
objects you create.

Duplicate object names

Because communities contain inherited objects and objects that you create, a community can contain
multiple objects that have the same name.

For example, if a parent community has a configuration named Finance, its subcommunity inherits that
configuration. You also can create a new configuration in the subcommunity named Finance. Support
Center displays the inherited community in regular text and the configuration you create in bold text.
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As a best practice, use unique names or unique descriptions for all objects you create.

Open Support Center

You can open Support Center from any computer with Internet Explorer 6.0 or later and a network or
Internet connection.

Open Support Center in the following ways:

l Subscription users. Open aWeb browser, and then enter the URL that the enterprise that hosts
the Data Center provides.

l Licensed users. Open aWeb browser, and then enter a URL in one of the formats described in the
following table:

SSL Status Using DNS or WINS to store
server names

Not using DNS or WINS to
store server names

SSL is enabled https://server_
name/supportcenter/

where server_name is the name of
the server that hosts Support Center

https://ip_
address/supportcenter/

where ip_address is the IP
address of the Support Center
server

SSL is not
enabled

http://server_
name/supportcenter/

where server_name is the name of
the server that hosts Support Center

http://ip_
address/supportcenter/

where ip_address is the IP
address of the Support Center
server

Internet Explorer preparation for FDCC environments

Youmust install the following applications in a Federal Desktop Core Configuration (FDCC)
environment to allow Internet Explorer access to Support Center in order to manage your Connected
Backup accounts:

l SCBrowserUtils.dll signed ActiveX control

l Adobe SVG viewer NPSVG3.dll ActiveX control

l Java runtime environment version 1.5/1.6

These applications require administrative rights to install.

SCBrowserUtils.dll Signed ActiveX Control

Support Center uses the SCBrowserUtils.dll ActiveX control for the following functions:

AdministeringMac Agents
Chapter 1: Agent overview

Connected Backup (8.11.5) Page 13 of 125



l Downloading Agent Setup files

l Uploading Agent File Sets

l Uploading Branding-related files

l UploadingMSI certificates

l Downloading report XML file results

l Running the ACE utility to update Legacy Agent configurations

To install the application

1. Use Internet Explorer to log in to the Support Center as a technician.

2. Navigate to an Agent configuration page to download an Agent Setup file.

3. During the page display, Internet Explorer prompts the user to install the SCBrowserUtils.dll
ActiveX control.

4. Click Install.

Internet Explorer installs the control. Once theDownload button is selectable, the control is
installed.

NOTE:

In Internet Explorer 8, to enable the ActiveX control

a. In Internet Explorer, select Tools > Manage Add-ons.

b. In theManage Add-ons window, right-click BrowserUtility Class, and then click
More Information.

c. In theMore Information window, click Allow on all sites, and then click Close.

d. Close theManage Add-ons window and return to Internet Explorer.

Adobe SVG Viewer NPSVG3.dll ActiveX Control

Support Center uses the Adobe SVG viewer ActiveX control to display graphical report results.

To install the application

1. Download the installation file for the control from http:///www.adobe.com/devnet/svg/adobe-svg-
viewer-download-area.html.

2. Install the control by running the setup file and following the on-screen instructions.

Java runtime environment

Support Center uses the Java runtime environment to launch and use the navigation tree
(ScTreeApplet.jar) and Agent (SignedAgent.jar) applets.
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To install the application

1. Download the installation file for the runtime environment from
http://www.java.com/en/download/manual.jsp.

2. Install the runtime environment by running the setup file and following the on-screen instructions.

Agent accounts

Each deployed Agent has an account in the Data Center. Each account has a unique 10-digit number
that identifies it. The Data Center uses this account number to label and organize all data that it backs
up from the client. To view the account number, search for an account in Support Center. Record this
number in case you need to reinstall the account.

As a technician, you can use Support Center to complete the following tasks:

l Change the account status.

l Manage account features.

l Manage security settings.

l Create and change Agent configurations.

As a user with native Connected Backup account credentials, you can use the Account Management
Website (AMWS) to perform the following tasks:

l Change your password.

l Update your profile (e-mail address, address, and telephone number).

However, if your account is mapped to an enterprise directory or a single sign-on account, you cannot
use AMWS to change your profile.

For more information about how tomanage accounts, seeManage accounts, on page 23.

Agent connections to Data Centers

To connect to the Data Center, the Agent can use any Transmission Control Protocol/Internet Protocol
(TCP/IP) connection, including local area networks (LANs) and wide area networks (WANs).

The amount of network traffic that Agents generate depends on the following conditions:

l Number of Agents that you deploy

l File backup rules

l Agent backup schedules relative to your network peak and off-peak hours of use for your network
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Agent connection properties

To connect to the Data Center, the Agent uses the DNS name or IP address of the Data Center server.
In amirrored configuration, you can designate which of two Data Center servers the Agent contacts as
the primary server.

The Data Center replicates data from one server to the other. If the primary server is busy, the Agent
connects to the secondary server to back up files and retrieve files.

When you run the Data Center setup, you can configure which Data Center server acts as the primary
server. You can designate different servers as the primary server for different communities. For
example, if youmanage amirrored configuration and have six distinct communities, you can designate
Server 1 as the primary server for Communities A, B, and C. You then can designate Server 2 as the
primary server for communities D, E, and F. When you designate different servers for different
communities, each server shares the volume of Agent transactions.

Proxy servers

If the client computer and the Data Center reside on different sides of a proxy server, configure the
Agent to connect to the Data Center through the proxy server.

The Agent can connect through the following proxy servers:

l SOCKS proxy server

l Non-SOCKS proxy server

l Software firewall

You configure the proxy server settings in Support Center. For more information, refer to Support
Center Help.

Connect through a SOCKS proxy server

When you use a SOCKS proxy server, all connections to the Data Center first require a connection to
the SOCKS server. The server then uses the IP/Port information in the Agent configuration to connect
to the Data Center.

To configure an Agent to connect to the Data Center through a SOCKS proxy server, use Support
Center to edit the proxy server settings. Specify the IP address and port number for the proxy server.
The Agent uses the SOCKS protocol to tell the proxy server the IP address and port number (16384) of
the Data Center.

If you use SOCKS, do not reconfigure your proxy server. For more information about how to configure
Agent proxy server settings, refer to Support Center Help.

Connect through a Non-SOCKS proxy server

If your enterprise uses a non-SOCKS-compliant proxy server, configure the Agent and your proxy
server to communicate with the Data Center. You configure the Agent proxy server information tomap
the Data Center IP address to the IP address of the proxy server, and you specify the port on which to
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connect to the proxy server. You can use domain names instead of IP addresses when you specify the
Data Center and proxy server mapping. If you use amirrored pair, designate this mapping for both the
primary and secondary servers.

The Agent uses themapping to connect to the IP address of the appropriate proxy server (using the
appropriate port) instead of connecting directly to the Data Center server. The firewall then routes the
connection to the Data Center that resides behind the proxy server.

Connect Through firewalls

TheMac Agent supports only the OS X built-in firewall.

Network interruptions

If the initial attempt to connect to a stand-alone Data Center server fails, the Agent records the failure in
the Agent History. In amirrored environment, if an Agent cannot establish a network connection to its
primary server, the Agent attempts to connect to the secondary server. If the Agent connects to its
secondary server, it proceeds as normal and completes its task. If the Agent cannot connect to its
secondary server, it records the failed attempt in the Agent History.

If an interruption in the network connection occurs or the connection fails during a backup or retrieval,
the Agent attempts to reconnect and finish the operation after it waits for a predefined period of time.
After the wait period, the Agent attempts to reconnect to the Data Center server. The Agent does not
attempt to connect to a different Data Center server to continue an aborted backup or retrieval. When
the Agent reconnects, it starts at the beginning of the last file it worked on before the connection failed.

Agent deployment tasks

You begin a first-time Agent deployment by logically grouping your user accounts into communities.
You then define Agent configurations that have appropriate permissions and features for each
community. You can have several different Agent configurations that you can assign to accounts and
communities individually.

After you create or modify an Agent, you can download the Agent Setup program to users’ computers
for registration and installation.

Create communities and subcommunities

You can configuremultiple Agent configurations, each with different properties, to suit the needs of
different groups in your enterprise. Before you create new Agent configurations, consider the different
groups in your enterprise and determine which Agent features benefit each group.

Use Support Center to create subcommunities based on factors such as department, geographical
location, or job function. After you create a subcommunity, you canmove an Agent configuration to that
subcommunity, or create a new Agent configuration with properties that meet the requirements of the
subcommunity.

For more information, see Set up communities and accounts, on page 20.
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Specify properties and settings

TheConfigurations node in Support Center contains the following types of Agent configurations:

l PC Configurations. PC Agent configurations.

l Mac Configurations. Mac Agent configurations.

Support Center can contain the following Legacy Agent configuration:

l Legacy PC Configurations. Version 7.x PC Agent configurations

To define an Agent configuration, youmust define the following components:

l Agent Versions. Determines the software version of the Agent and the language.

l Agent Settings. Determines the settings and features available to users.

l Agent Rule Sets. Determines the files included and excluded for backup.

l Profile and Website Settings. Determines the features that users can gain access to through the
Account Management Website. The Account Management Website lets users register accounts,
download Agent software, andmanage their accounts.

For more information about Agent settings, versions, and rules, see Create Agent configurations, on
page 40.

Distribute the Agent software

After you define the Agent features during configuration, Support Center creates an Agent Setup
program (AgentSetup.mpkg) that installs the Agent software on a client computer. The Agent Setup
program is in the AgentSetup.zip file.

To distribute the file, use the followingmethods:

l Account Management Website. Users log on to this Web site to register accounts and download
the Agent Setup program. You can use the Account Management Website to distribute only files
customized for one user. If you use this method to distribute the files to other users, the backup
process does not work correctly. All users must download their own file from the Account
Management Website. For more information, refer to InstallingMac Agents.

l Support Center download. You can download the Agent Setup program from Support Center and
distribute a generic Agent Setup file to users so that they can install the Agent themselves. For more
information, refer to InstallingMac Agents.

l Disk image distribution. You can install an Agent on a computer and then create a disk image to
clone to other computers. For more information, refer to InstallingMac Agents.

l Hands-free installation. You can download the Agent Setup file from Support Center and use the
installation command-line interface to install the Agent onmultiple computers simultaneously
without user participation. For more information, refer to InstallingMac Agents.
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Register and install the Agent

When you register an Agent, the Data Center establishes an account for the Agent. The account
identifies the Agent client computer to the Data Center server. An account number in the Data Center
represents the client computer and the files on that computer.

Installation and registration occur in one of the following ways:

l After a user logs on to Account Management Website (AMWS) and enters profile information,
AMWS communicates with the Data Center to register a new account. Each user must register on
the Account Management Website individually to get an Agent Setup program file that is particular to
the user’s account. After the user registers the Agent, the user downloads the Agent Setup program
and installs the Agent. The Agent Setup program (AgentSetup.mpkg) is contained in the
AgentSetup.zip file.

l After you download the Agent Setup program from Support Center, you install and register the Agent
in one of the following ways:

o Use the Agent Startup Wizard. To use theWizard, a technicianmust use Support Center to
enable it for the Agent configuration. For more information, refer to InstallingMac Agents.

o Use the Agent installation command-line interface. You can use an XML file to specify
registration information. For more information, refer to InstallingMac Agents.

If you do not provide registration information, the Agent registers anonymously. That means that the
Data Center identifies the Agent by only a computer name, and not by a user name.

During registration, the Data Center assigns a 10-digit account number to the Agent. The Data Center
uses the account number to label and organize the data it receives in a backup. The Agent account is
unique to the computer. You cannot use the same account number to install more than one Agent. Also,
you cannot havemultiple Agents or accounts on the same computer.

The Data Center tracks each Agent that you register and the total number of registrations against the
total number of users permitted by your organization’s license agreement, and the number of licenses
allocated to a community where the Agent registers. When you use up the licenses, the Data Center
does not accept new registrations from Agents until you buy more licenses, allocate additional licenses
to the community, or cancel unused accounts.
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Chapter 2: Set up communities and
accounts

This chapter explains how to set up communities and subcommunities, manage accounts, work with
technician accounts, allocate andmanage licenses, and apply bandwidth throttling to Agent backups.

l Communities, below

l Subcommunities , on the next page

l Manage accounts, on page 23

l Managing general account functions, on page 26

l Agent Security, on page 29

l Technician accounts, on page 30

l Licenses for Agent accounts, on page 31

l Manage licenses and licensed features, on page 34

l Apply bandwidth throttling during Agent backups, on page 38

Communities

A community is a group of Agent accounts that share common characteristics, such as configuration
settings, the geographical location of the clients, or similar bandwidth throttling requirements. You can
use communities to run reports, edit settings, upgrade Agent configurations, andmanage accounts.

Communities in Support Center

Each community that you create in Support Center appears as a node in the left pane of the Support
Center interface. The node contains subnodes that represent the accounts, technicians, reports,
configurations, and subcommunities in the community.

Each community or subcommunity inherits objects from the top-level community Data Center (root
level) node. For example, technicians whose permissions you define in the root level of your
community can gain access to all subcommunities. You can use the Agent configurations, reports, and
other objects that are defined at the root level of your community in any subcommunity.

The Default community

If you host your Data Center, depending on the permissions that are assigned to your technician
account, youmight have access to a community labeledDefault. When you install a self-hosted
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Support Center, the installation procedure creates this default community.

The Default community includes the Default Agent configuration, which contains default settings and
rules. You can use this community to organize your Agents, or as amodel to construct your
communities. Youmust set the correct permissions for the technician account that you use to log on to
Support Center so that the account allows you access to the Default community.

If you do not host your ownData Center, you have access to specific subcommunities in the Default
community. However, youmight not have permissions to gain access to the top-level Default
community.

New communities

You can create as many communities and subcommunities as necessary to organize your accounts.
All subcommunities that you create inherit the default Agent configuration in the root community.
However, any new Agent configurations that you create in a new subcommunity are available only to
that subcommunity and any of its subcommunities.

For more information, refer to Support Center Help.

To create a new community

1. Log on to Support Center.

2. Click Tools > Add Community.

The Add Community page opens.

3. In theCommunity Name field, enter a community name.

4. Click Save.

The name of the community appears in the left pane of the Support Center. The community node
contains subnodes representing the accounts, technicians, reports, and configurations for the
community.

IMPORTANT:
You can rename andmove communities. However, you cannot delete communities.

Subcommunities

You can create subcommunities in any community that you can access. You can use subcommunities
to divide your Agent accounts into smaller categories, based on geographic location, departments,
bandwidth throttling, or other criteria. You can reassociate a subcommunity with a different parent
community, which is useful if you want your communities to reflect the changes in your organization.
For more information, refer to Support Center Help.

NOTE:
Tomanage Agents more easily, create separate subcommunities for each type of Agent that
you plan to deploy. Also keep Agent configurations for different operating systems in separate
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subcommunities.

For more information about Agent configurations, see Create Agent configurations, on page 40.

Create subcommunities

To create a subcommunity

1. Log on to Support Center.

2. Click the community for which you want to create the subcommunity.

3. From the Toolsmenu, select Add Subcommunity.

The Create Subcommunity page opens.

4. In theCommunity Name field, enter a name for the subcommunity.

5. Click Save.

The name of the subcommunity appears in the left pane of the Support Center. The subcommunity
node contains subnodes representing the accounts, technicians, reports, and configurations for
the community.

For more information, see the Support Center Help.

Agent accounts in subcommunities

Agent accounts in a subcommunity share characteristics with the parent community, but they have
distinct characteristics that set them apart from the parent community. For example, youmight create
one community to represent the Agents in your branch office. In this parent community, you can create
subcommunities to represent the departments in the branch office, such as Finance, Accounting, and
Marketing.

The Agents in each subcommunity inherit versions, settings, and rule sets from the parent community.
They also can contain configurations unique to each subcommunity. For example, you define common
rules at the community level for your entire organization. Then, for each group in your organization, you
have subcommunities for which you can define unique settings. You then use the common rules and
the Agent settings that you define for each group to create Agent configurations for each
subcommunity.

Disable registration in communities

After you deploy Agents throughout your enterprise, you can use Support Center to disable registration
for communities and subcommunities. When you disable registration, no one can use a copy of Agent
Setup to register an account that you did not intend to create. If youmust add new accounts to the
community or recover an account, you can enable registration.
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Manage accounts

Use Support Center to perform the following account management tasks:

l View an account number.

l View account information.

l Change account status.

l Manage general functions.

l Manage Agent security.

l Gain access to the Account Management Website to manage an account.

View an account number

Each deployed Agent has an account in the Data Center. Each account has a 10-digit number that
uniquely identifies it. The following is an example of an account number:

10203-61718

The sixth digit in the account number (the digit following the dash) is a check digit. Some of the Data
Center database tables drop the check digit and use a nine-digit format instead (for example,
102031718.)

The Data Center uses this account number to label and organize all data backed up from the client.

You can view an account number in the following ways:

l From the Agent interface

l From Support Center

To view your account number from the Agent interface

1. Open the Agent interface.

2. Click Connected Backup > About Connected Backup.

The About Connected Backup window opens. Your account number is at the bottom of the
window.

You can use the Agent interface to view the number of only your own account.

To view an account number from the Support Center

1. Use your technician ID and password to log on to Support Center.

The organization that hosts your Data Center provides the URL you need to log on.

2. In the left pane of Support Center, click Accounts.

The Account Search page opens in the right pane.
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3. On the Account Search page, enter one of the following kinds of information:

l Account name

l Organization name

l Department

4. Click Search.

The Accounts page lists the account number for every account that matches the search criteria.

View Account Information

To view information about an account

1. Log on to Support Center.

2. In the left pane of Support Center, click Accounts.

The Account Search page opens in the right pane.

3. On the Account Search page, enter one of the following kinds of information:

l Account name

l Organization name

l Department

l Account number

TIP:
The fastest way to find an account in Support Center is to search for the account
number. If you do not know the account number, you can use the account name,
organization name, department, or other identifying criteria to search for the account.
For more information, refer to Support Center Help.

4. Click Search.

The Accounts page opens and lists the account number for every account that matches the
search criteria.

5. Click the number of the account.

The Account Summary page opens and lists information about the account.

Change account status

The status of an account determines whether the account can connect to the Data Center. If you
change the account status, you can temporarily or permanently disable backup and retrieval for an
Agent.

For example, change the account status to block access to the Data Center from client computers that
were stolen or are no longer used. When an employee leaves your organization, you can cancel the
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account for that employee so that unauthorized users cannot gain access to the files that the former
employee previously backed up.

The account status includes the following options:

Status
option

Description

Active An account can connect to the Data Center and perform backup and retrieve operations.

On Hold An account temporarily cannot connect to the Data Center and perform backup and
retrieve operations.

For example, you can place an account on hold if a employee associated with the
account takes a long-term leave from your organization. When the user returns, you can
change the status of the account back to Active.

Canceled An account cannot connect to the Data Center and perform backup and retrieve
operations. The Compactor labels the information that the Agent backed up as expired
and, after a defined expiration period, removes the information from the Data Center
server.

For example, you can cancel a user account if the employee associated with the
account permanently leaves your organization.

Canceled
and Data
Deleted

The compaction process ran on a canceled account, and the files, archives and
encryption key associated with the account no longer exist on the Data Center.

TIP:
To cancel or place on holdmultiple SSO-enabled accounts at the same time, use the
CancelHoldAccounts command-line utility. For more information about this utility, which is part
of the DC toolkit, refer toAdministering the Data Center.

To change the status of an account

1. Open Support Center and search for the Agent account.

2. When Support Center displays the search results, click the Agent account number.

The Account Summary page opens.

3. On the Account Summary page, click Account Status.

The Change Account Status page opens.

4. Select a status option.

For more information, refer to Support Center Help.

5. To save your changes, click Change Status Now.
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Managing general account functions

Use Support Center to manage the following general account functions:

l Reserve accounts.

l Change the primary server for an account.

l Change an Agent configuration.

l Sendmessages to Agents.

l Display backupmessages.

Reserve accounts

As an alternative to the standard account registration, you can reserve accounts in specific
communities. To reserve accounts, you can use Support Center to generate account codes. Users can
enter the code or ticket to register under the Agent community.

When users register new accounts, the Data Center verifies the code or ticket that they specify. If the
code or ticket is valid, the Data Center registers the account in the community where the technician
created the reservation.

NOTE:
Reserved accounts use client licenses on the Data Center in the sameway as Active
accounts.

For more information about how to reserve accounts, see Support Center Help.

Change the primary server for an account

In mirrored or clustered environments, Agents use one Data Center server as their primary server
during backup or retrieval. The Agent always attempts to contact its designated primary first. If the
primary is offline, the Agent connects to themirror of the primary server to complete the operation.

You can use Support Center to change the primary server to the secondary server.

To designate a primary server for an Agent

1. Open Support Center and search for the Agent account.

2. When Support Center displays the search results, click the Agent account number.

The Account Summary page opens in the right pane.

3. On the Account Summary page, click Primary Server.

If the Agent does not belong to a clustered or mirrored environment, Primary Server is not a link.

The Change Primary Server page opens.
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4. Select a primary server.

5. To change the primary server to the one that you selected, click Save.

For more information, see Support Center Help.

Change an agent configuration

The Agent configuration determines the following:

l Agent rules

l Security settings

l Interface controls

l Profile andWebsite settings

If you usemultiple configurations within one community, you can change the configuration of an Agent
in that community. The next time that the Agent connects to the Data Center, the Agent downloads the
new configuration.

To change an Agent configuration

1. Open Support Center and search for the Agent account.

2. When Support Center displays the search results, click the Agent account number.

The Account Summary page opens.

3. Click theAssigned Configuration link.

The Change Agent Configuration page opens.

4. Select the appropriate configuration from the displayed list.

5. To change the configuration to the one that you selected, click Save and Deploy.

For more information, see Create Agent configurations, on page 40 and see Support Center Help.

Send informational messages to Agents

You can send informational messages to Agents. For example, you want to provide instructions to
users for an upcoming Agent configuration upgrade. This feature is different from themessage
notification that you can enable when you change the status of an account. For more information about
how to change the status of an account, see Change account status, on page 24 and refer to Support
Center Help.

When you create informational messages, the Agent receives themessages the next time it connects
to the Data Center. If configured to do so, the Agent displays amessage notification window that it
received one or moremessages from the Data Center. Users must open the Agent User interface to
view themessages in theMessage panel of the Summary tab.
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To send a message to one or more Agents

1. Log on to Support Center.

2. Search for an account or create an account group.

3. Perform one of the following actions:

l To send amessage to a single account, from the Account Summary page, select Tools >
Send Message to Agent.

l To send amessage to a group of accounts, from theGroup Accounts page, select Group >
Send Message to Agents.

4. In the SendMessage to Agent page, enter themessage that you want to send.

5. Click Send Message.

For more information, see Support Center Help.

Display backup messages

Depending on your Agent configuration, the Agent can display amessage notification window in the
following situations:

l When a backup completes and the Agent User interface is closed

l When a backup does not successfully complete after four days.

To enable backup messages

1. Log on to Support Center.

2. Select a community and expand theConfigurations node, then expand theMac subnode.

TheMac Agent Configuration summary page opens.

3. Expand theAgent Settings node, and select a setting configuration.

The Edit Agent Settings - General page opens.

4. On the Edit Agent Settings - General page, click Display.

The Edit Agent Settings - Display page opens.

5. In theMessages section of the Edit Agent Settings - Display page, select themessage setting
that you want to enable.

6. Click Finish.

For more information, refer to Support Center Help.
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Use the Agent Dock icon

The Agent icon always appears on the Dock unless you remove it. Use the Agent icon to open the
Agent window and view the status of the Agent during backup and retrieval, and to open the Agent
Dock menu.

The appearance of the Agent Dock icon indicates whethser a backup or retrieval is in progress, or the
outcome of the last backup. The following tables describes each variation of the Agent Dock icon:

Agent Status Icon
Appearance

Indicates

No backup has been performed since this Agent was installed, and no
backup is in progress.

A backup is in progress.

A file retrieval is in progress.

When the Agent is open, you can gain access to the Dock menu options from the Agent Dock icon. To
open the Dock menu, right-click the Agent Dock icon.

The following table describes the Dock menu options:

Menu item Task

Back Up Now Start a manual backup.

Cancel Backup Cancel a backup.

About View Agent version information.

Manage Account
Online

Manage your account using the Account Management Website, if it is
enabled for your account.

NOTE:
The Connected Backup Agent does not display the Dock menu options onMac OS 10.6 (Snow
Leopard).

For more information, see Support Center Help.

Agent Security

Every account has an encryption key that the Agent creates during installation and registration. The
Agent and Data Center uses the encryption key to encrypt and decrypt each file that the Agent backs
up.
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For additional security, you can configure the Data Center to notify users by e-mail when anyone
retrieves a file from an account. Technicians can take appropriate action if an unauthorized person
retrieves files from a specific account.

You can enable e-mail notification at the community or subcommunity level. You cannot configure e-
mail notification for specific Agent configurations.

NOTE:
Ensure that the DCAlerter service is running and configured with a valid e-mail server. For more
information about how to configure the DCAlerter service, refer to Data Center Management
Console Help.

To enable e-mail notification

1. Log on to Support Center.

2. Select a community or subcommunity.

3. Click Tools > Email Notification.

The Change Email Notification Status page opens.

4. Select the appropriate option and click Save.

For more information, see Support Center Help.

Technician accounts

Technician accounts let you control who has access to Support Center, and who has access to the
Agent retrieve feature.

An administrator assigns the Support Center Administrator technician ID during the Data Center
installation. The technician ID provides access to Support Center controls. Use this technician ID to
create your subcommunities and other technician accounts.

If you want multiple staff members to use Support Center, create a technician account for each staff
member. You can set permissions to control the level of access a technician has to Support Center
features. For example, youmight limit a technicians’ access to specific communities.

To create a technician account

1. Log on to Support Center.

2. Select a community.

3. Select the Technicians node.

4. In the Add Technician page, enter the required information and select the permissions you want to
assign to the account.

5. Click Add Technician.

For more information, see Support Center Help.
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Licenses for Agent accounts

The Data Center licenses control the number of accounts that you can connect to a Data Center. They
also enable licensed features such as MyRoam.

If you host your Data Center, you receive a license file to use when you install the Data Center. For
more information, refer to Installing the Data Center.

If you back up your files to a Data Center that another company manages, one of the following can
occur:

l Your top-level community inherits unused licenses from a parent community.

l The technician that manages the parent community allocates a specific number of licenses for your
top-level community.

How licenses affect the Support Center display

Based on the types of licenses that you buy, Support Center displays the following configuration nodes
in the left pane of the user interface:

Software Licenses Version Support Center display

PC andMac Agents 8.3 and later Configurations node, PC subnode, andMac subnode

PC Agents 8.0 through 8.2.2 Configurations node, PC subnode

Legacy PC Agents 7.x and earlier Legacy PC Configurations node

If you log on to Support Center and you or another technician changes the licenses, Support Center
does not display the change in the left pane until you refresh the view or log into a new session.

For example, if you log on to Support Center and another technician removes licenses for PC andMac
Agents, you continue to see thePC andMac subnodes under theConfigurations node until you start a
new session.

License inheritance and allocation

When you register an Agent in a community or subcommunity on the Data Center, the registration
completes only if a license is available. Additionally, without an available license, the Agent cannot
connect to the Data Center.

A technician can allocate licenses to subcommunities, or subcommunities can inherit licenses from a
parent community. By default, lower-level communities inherit licenses from parent communities. For
example, if your top-level node in Support Center has access to 1,000 licenses and you create two
communities below the top-level node, each subcommunity has access to the 1,000 unused licenses in
the parent community.

You can use license allocation to control the number of licenses to each community or subcommunity
can access. For example, you have a total of 1,000 licenses available, and you have two communities:
Operations and Engineering. If you expect the Engineering community to require more registered
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accounts than the Operations community, you can allocate 700 licenses to the Engineering community
and 300 licenses to the Operations community. You can adjust the allocation of licenses at any time.

PC Agents andMac Agents share the same license pool. For more information about license
inheritance and allocation, see License allocation examples, on page 34.

Used and unused licenses

The Data Center considers a license in use when any of the following conditions exist:

l Accounts register in a community.

For example, a community has access to 500 licenses and 100 accounts register in the community.
The number of licenses in use for the community is 100 and the number of unused licenses is 400.

l You allocate a specific number of licenses to a subcommunity.

For example, your top-level community has 1,000 licenses available for use, and you allocate 600 of
the licenses to a subcommunity. The number of licenses in use in the top-level community is 600
and the number of unused licenses is 400.

l Accounts register in a community and you allocate some of the licenses to a subcommunity.

For example, your top level-community has 1,000 licenses. A hundred accounts register in the top-
level community, and you allocate 600 licenses to a subcommunity. The number of in use licenses
is 700 and the number of unused licenses is 300.

Licensed features for communities

You can enable or disable theMyRoam feature for a selected community.

Feature state inheritance

Each feature in a community inherits its default state from the parent community. However, you can
enable a feature in a parent community and disable the feature in its subcommunities. You also can
disable MyRoam at the configuration level. For more information, refer to Support Center Help.

If you change the state of licensed features in a parent community, you affect its subcommunities in
the following ways:

l If you disable licensed features in a parent community, you disable the features in its
subcommunities. For example, you enableMyRoam in a subcommunity and disable MyRoam in the
parent community. As a result, you also disable MyRoam in the subcommunity.

l Licensed features in subcommunities return to their previously set states if you re-enable licensed
features in the parent community. For example, you disable a licensed feature in a subcommunity
and in the parent community. You then re-enable the licensed feature in the parent community. As a
result, you also re-enable the feature in the subcommunity.

For more information, see Support Center Help.
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Expired licenses

When licenses expire, the following behavior occurs:

l If licenses in the Data Center License File expire, the Data Center server no longer accepts
connections from Agents.

l If the licenses for a product type (PC orMac) expire, the Data Center no longer accepts connections
from those Agents.

l If licenses expire, new Agents cannot register in the Data Center.

l If a registered PC Agent attempts to back up files or retrieve files, and the licenses expire, the
process fails. The History tab in the Agent User interface displays a failed event.

l If a user attempts to register an account with an expired license, the Account Management Website
informs the user that the license is not valid.

To get more licenses, contact your Sales Representative.

Effect of licenses on accounts and communities

The availability of unused and unexpired licenses affect the following tasks:

l Agent registration

If no licenses are available in a community, or if the licenses expire, new Agents cannot register in
the Data Center and the Account Management Website displays an error message. If the Agent
cannot register an account, it cannot back up or retrieve files. To let new Agents register, buy or
allocate additional licenses to the affected community.

l Changing account status

o If no unused licenses exist for the community in which an account is registered, you cannot
change its status to Active or OnHold.

o If you change the status of an account to Canceled, the license that the account used becomes
available. A new account can register and use this license.

o If you change the status for multiple accounts simultaneously, and you do not have an available
license for every accounts in the group, the Data Center changes the status for only a subset of
the selected accounts.

o The Data Center does not change the status for all accounts. The Results page in Support
Center lists the changes that did not occur. For example, a community had five available
licenses, and you tried to change the status of seven accounts. The status of two of the accounts
remains the same.

l Moving communities

When youmove communities from one location to another, the destination community must have a
sufficient number of unused licenses for the communities that youmove.

For example, you have a community named Accounting that has 500 licenses allocated for its use,
and you want to move it to a new parent community namedGlobalOperations. TheGlobalOperations
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community must have at least 500 or more unused licenses to accommodate the Accounting
community.

After youmove a community, the licenses that it used become available to the original parent
community and themoved community uses licenses that it obtains from its new parent community.

l Moving accounts

If youmove an account from one community to a different community, the new community must
have an unused license of the appropriate product type that the account can use. After youmove the
account, the license it used in the original community becomes available. Themoved account uses
a license from its new community.

If youmove a group of accounts from one community to a different community, and the new
community does not have enough licenses of the appropriate product type for all of the accounts,
Support Center moves some accounts and displays amessage that indicates that some accounts
did not move. Tomove the remaining accounts, buy or allocate additional licenses to the
community.

Manage licenses and licensed features

This section contains an example of license allocation. It also describes how to perform the following
tasks:

l Allocate licenses.

l Enable or disable licensed features.

License allocation examples

Assume that you host your Data Center. Your Data Center License File provides you with 5,000
account licenses.

After you install your Data Center, you create the following communities:

l Engineering

l Accounting

l Marketing

Inherited licences

Initially, all communities inherit the licenses. Because you have not yet explicitly allocated the
licenses, each community has access to the 5,000 licenses. The following figure shows the initial
license allocation.
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As users register accounts in the individual communities or as you allocate licenses to other
communities, the number of licenses in use increases and each community that inherits its licenses
has access to fewer licenses.

For example, 100 accounts register in the Engineering community, and you do not explicitly allocate
any licenses to other communities. You have 4,900 unused licenses to which all communities have
access.

Allocated licenses

To control the use of licenses, and to avoid a situation where one community runs out of needed
licenses, you allocate some of the licenses. In addition, your enterprise charges other enterprises for
backup services, so youmust control the number of licenses to which other enterprises have access.

You know the following information:

l The Engineering division has 500 client systems that must back up their data.

l The Accounting division has 300 client systems that must back up their data.

l TheMarketing division has 50 client systems that must back up their data.

After you allocate required licenses to each division, you have 4,150 unused licenses and 850 licenses
in use. In this example, a license is in use after you allocate it to another community. If you create
another community and let it inherit licenses, it would have access to the 4,150 unused licenses.

The following figure shows the license allocation for this example.

AdministeringMac Agents
Chapter 2: Set up communities and accounts

Connected Backup (8.11.5) Page 35 of 125



Licenses allocated to subcommunities

The Engineering division can create subcommunities and allocate licenses to these subcommunities.
After you inform the Engineering division that their community is available, the administrator in the
Engineering division divides the community into the following subcommunities:

l Product A

l Product B

Initially, the Engineering community and each subcommunity has access to the 500 allocated licenses,
with the following use of licenses:

l Fifty accounts register in the top-level community. Each subcommunity now has access to 450.

l You allocate the remaining unused licenses as follows:

o Product A receives 100 licenses.

o Product B receives 200 licenses.

You have 150 remaining licenses. Up to 150 new accounts can register in the top-level community, or
you can allocate any of these licenses to existing subcommunities or to a new subcommunity, or both,
as shown in the following figure:
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Allocate licenses

Tomake it easier to manage licenses, create different communities for different types of licenses. For
example, create a community for Mac licenses, and a different community for PC licenses.

To allocate licenses

1. Log on to Support Center. Use a technician ID that has permissions to allocate licenses in sub-
communities.

2. In the left pane of the Support Center interface, select a community or subcommunity.

3. On the Community Status page, click Allocate Licenses.

The Allocate License page opens.

4. Select the appropriate allocation options.

For more information, see Support Center Help.

5. To save your selections, click Save.

Support Center displays the followingmessage:

The license allocation changes have been saved.

If you do not have permission to allocate licenses for a selected community, Support Center displays
the View License Summary page instead of the Allocate Licenses page. You can use this page to view
the current license allocation.

For more information, see Support Center Help.
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Enable or disable licensed features

To manage licensed features

1. Log on to Support Center. Use a technician ID that has permissions to allocate licenses in sub-
communities.

2. In the left pane of the Support Center interface, select a community or subcommunity.

3. On the Community Status page, click Manage Features.

TheManage Features page opens.

4. In theManage Features dialog box, select the feature that you want to enable or disable, and then
click Save.

Support Center displays the followingmessage:

The Manage Feature changes have been saved.

Formore information, see Licensed features for communities, on page 32.

Apply bandwidth throttling during Agent backups

You can use the bandwidth throttling feature to limit the amount of network bandwidth that Agents use
during backups. If you throttle bandwidth during Agent backups, you can allocatemore bandwidth to
other network activities and to user’s Internet applications. When you use bandwidth throttling for
Agent backups, backups are less intrusive, but take longer to complete.

NOTE:
l Bandwidth throttling applies to only Agent backups. It does not apply to Retrieve operations.

l Set bandwidth throttling limits that are appropriate for your network. The Data Center does
not check the available bandwidth of your network against the bandwidth throttling limits that
you set in Support Center. If you set maximum bandwidth limits that exceed actual data
transfer speed of your network, the bandwidth throttling does not reduce Agent intrusiveness
during backups.

You can set the following bandwidth limits:

l Minimum bandwidth required for an Agent to perform a backup

l Maximum bandwidth to allocate to an Agent performing a backup

l Maximum bandwidth to allocate to all Agents performing backups

You also can establish a schedule to identify the peak, medium peak, and off peak network traffic
times, and vary the bandwidth allocations accordingly.

You can configure bandwidth throttling at the Data Center level and the community level. At the Data
Center level, you can choose whether to throttle bandwidth for all accounts that the Data Center
manages. At the community level, you can choose whether to throttle bandwidth for the accounts in the
community, or you can choose to inherit the bandwidth throttling configuration (throttled or not throttled)
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from the parent community. When a subcommunity inherits bandwidth throttling from its parent
community, and you specify amaximum shared bandwidth, themaximum shared bandwidth is shared
among all Agents in the parent communities and any subcommunities that inherit bandwidth throttling.

To configure bandwidth throttling

1. Log on to Support Center.

2. In the left pane of the Support Center interface, select a community or subcommunity.

3. On the Community Status page, click Bandwidth Throttling.

The Bandwidth Throttling - Options page opens.

4. Select a bandwidth throttling option.

For more information, click Help.

5. Click Save.

Support Center displays the followingmessage:

Your bandwidth throttling options have been saved.

Formore information, see Support Center Help.
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Chapter 3: Create Agent configurations

This chapter explains the components that make up an Agent configuration. It also explains how to
create Agent configurations.

l About Agent configurations, below

l Configuration components, below

l Create an Agent configuration, on page 42

About Agent configurations

You create Agent configurations in Support Center to specify the features that are in the Agents that
you deploy. Agent configurations also contain the settings and rules that control the behavior of an
Agent after you install it on a client computer.

Support Center supports the following types of Agents:

l 7.x Legacy PC Agents

l 8.x or later PC Agents

l 8.3 or later Mac Agents

Configuration components

An Agent configuration contains the following components:

l Profile andWebsite settings

l Agent versions

l Agent settings

l Agent rule sets

Support Center compiles Agent configurations from a set of components that each specify some of the
Agent features. You can gain access to the configuration information for each community.

To gain access to the configuration information for a community

1. Open Support Center.

2. In the left pane of the Support Center interface, under the name of the community in which the
Agent resides, expandConfigurations, and then expandMac.

The following sections describe the configuration components in detail.
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Profile and Website settings

The Profile andWebsite settings determine the information and features that are available to users in
the Account Management Website. They also determine the information that is in users’ profiles, and
the fields that are in the Agent StartupWizard. In Support Center, the Profile andWebsite settings for
each community appear in theConfigurations node.

For more information about the Account Management Website, see Deploy Account Management
Website, on page 67.

For more information about Profile andWebsite settings, see Support Center Help.

Agent versions

Agent versions point to an Agent file set of a specific version and language. For example, you have an
Agent version namedMarketing PC. When a new version of the Agent software becomes available,
you can download the new version and apply it to your deployed Agents.

For best practice, consider the following recommendations:

l When you create new Agent version in Support Center, do not include the version number in the
name. For example, do not useMarketing versionX. Instead, useMarketing. If you include the
version number in the name, the name becomes obsolete when you update the Agent version.

l Based on the needs of your organization, youmight need to create one or more Agent versions. For
example, you have computers in different departments with different backup requirements. You can
create an Agent version for each department.

l You can use the same Agent version with several or all Agent configurations. When a new version of
the Agent software is available, update only the Agent version and not every Agent configuration.

Agent settings

The Agent has optional features specific to your license agreement that you can enable or disable.
Agent settings determine which features are accessible to the Agent user. The settings contain
parameters that govern the Agent backup and retrieve features, such as the backup schedule and
backup type. You also can enable security features such as proxy server settings and password
protection of retrievals.

Agent rule sets

The Agent uses rule sets to determine which files to select during a backup. You can specify Agent
rules in Support Center when you create or modify an Agent configuration.

Support Center includes a default rule set that you can associate with one or moreMac Agent
configurations. You also can create your own rule sets. If you let users modify their backup sets, they
also can create rules that determine which files the Agent selects for backup. For more information, see
Create Agent rule sets, on page 46.
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Default Agent configuration

The Support Center installation creates a default Agent configuration. The default configuration has a
name similar to Default Mac versionConfiguration, where version is the Agent version number. The
default configuration resides at the root level of the tree in Support Center and is available to all of your
communities. Youmight want to create your own configuration with a unique version, settings, and
rules. However, you can use the default configuration as a reference when you create your own
configurations.

For more information, see Support Center Help.

The default configurations contain the following components:

l Default Agent Version

l Default Agent Settings

l Default Agent Rule Sets

l Default Profile andWebsite Settings

Create an Agent configuration

Use Support Center to create the Agent configuration and its components. The technician ID that you
use to log on to Support Center must include theModify Agent Configurations permission.

NOTE:
You cannot use the Support Center application from a computer with Mac OS X. Use Internet
Explorer installed on aWindows operating system to open Support Center.

To create an Agent configuration

1. Allocate licenses.

2. Create an Agent version.

3. Create Agent settings.

4. Create Profile andWebsite Settings.

5. Create an Agent rule set.

6. Create the Agent configuration.

The following sections describe these steps in greater detail.

NOTE:
Perform the steps to create an Agent configuration in the order in which the steps appear in the
guide.
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Allocate licenses

To create a new Agent configuration for a community, the community must have at least one available
license.

To verify that a community has at least one available license

1. In the left pane of the Support Center interface, click the community node.

The Community Status page opens.

2. In theAccount Summary section, look at the value in theUnused column for thePC and Mac
license type and verify that at least one unused license is available.

If no licenses are available, you can change your license allocations.

3. To change your license allocations, click Allocate Licenses.

The Allocate Licenses page opens.

4. Select the appropriate allocation options.

For more information, click Help.

5. To save your selections, click Save.

Support Center displays the followingmessage:

The license allocation changes have been saved.

Create an Agent version

To create an Agent version

1. Expand theConfigurations node in the community where you want to create the configuration.

2. Expand theMac node.

3. Click Agent Versions.

The Create Agent Version page opens.

4. Enter the Agent version information.

Only Mac Agent versions are available in theAgent drop-down list.

5. Click Create.

The Edit Agent Version - Description page opens.

6. Enter a description for the version, then click Save and Deploy.

The name of the Agent version appears in the left pane under theAgent Versions node.
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Create Agent settings

To create Agent settings

1. Expand theConfigurations node in the community where you want to create the configuration.

2. Expand theMac node.

3. Click Agent Settings.

The Create Agent Settings - General page opens.

4. Configure the Agent Settings.

For more information, click Help.

5. When you complete the Agent Settings, click Finish.

The name that you assigned to the setting appears in the left pane under theAgent Settings
node.

Create Profile and Website settings

To create Website settings

1. Expand theConfigurations node in the community where you want to create the configuration.

2. Click Profile and Website Settings.

The Create Profile andWebsite Settings - General page opens.

3. When you complete theWebsite settings, click Finish.

The name that you assigned to the setting appears in the left pane under theProfile and Website
Settings node.

For more information, click Help.

Create an Agent rule set

To create an Agent rule set

1. Expand theConfigurations node in the community where you want to create the configuration.

2. Expand theMac node.

3. Click Agent Rule Sets.

The Create Rule Set page opens.

4. Configure the rule set.

For more information, click Help on each page of the Rules wizard.

5. When you complete the rule set, click Finish Rule Set.
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The name that you assigned to the rule set appears in the left pane under theAgent Rule Sets
node.

Create the Agent configuration

To create a new Agent configuration

1. In Support Center, expand a community node, and then expand theConfigurations node.

2. In the right pane, clearUse inherited configuration settings.

If you do not clear this setting, the configurations that you create for the community are inactive.
That means that you cannot download an Agent Setup file from the community.

3. Click theMac subnode.

4. In the right pane, on the Configurations menu, click Create.

5. Enter ameaningful community name, such as “Finance Department.”

6. From the drop-down lists, select the following:

l An Agent version

l Agent settings

l Profile andWebsite settings

l Agent rule set

Each list contains the components you previously created and the default components.

7. To create the configuration, click Save and Deploy.

After you create the Agent configuration, two things happen:

l TheDownload menu becomes available. If you want to distribute the Agent Setup file, use
this menu to download it to your computer.

l If the Account Management Website is installed for your Data Center, a URL for Account
Management Registration appears. Copy and send this case-sensitive URL to users whom
you want to register and install an Agent account.
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Chapter 4: Create Agent rule sets

This chapter explains the types of rules that the Agent uses to determine which files to include and
exclude in backup. It also explains how to use Support Center to create rules.

l Rule types, below

l The rule matching process, below

l Rule categories, on page 49

l Create rules, on page 50

Rule types

The Agent uses rules to determine which files to include or exclude from backups and recoveries.

Rule types determine the order in which the Agent processes rules. The following table describes the
rules types that the Agent uses and how they determine processing order:

Rule
Types

Description

Locked Rules that technicians define through the Support Center. Other types of rules cannot
override locked rules.

The Agent tries to match files with locked rules before it examines any other type of
rule.

User-
created

Rules that users define on their local Agent and associate with files on their local
system.

To define user-created rules, users must have permission tomodify their backup sets.

User-created rules do not override locked rules, but they override unlocked rules.

The Agent tries to match files with user-created rules after it examines locked rules.

Unlocked Rules that technicians define from the Support Center.

Locked rules and user-created rules override unlocked rules.

The Agent tries to match files with unlocked rules after it examines locked rules and
user-created rules.

The rule matching process

The Agent processes rules according to the following factors:
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l Rule logic. The way the Agent processes each type of rule (locked, user-created, or unlocked). For
more information about rule types, see Rule types, on the previous page.

l Rule precedence. The position of rules in the rule list.

When the Agent scans a drive, it examines locked rules first. The Agent moves through the list of
locked rules in top-down order until it finds a rule that applies to one or more files. You determine the
precedence of rules in a list when you use the Support Center Rules wizard to create the rule set.

Rule logic

If the Agent matches a locked rule to a file or group of files, the Agent stops comparing thematched file
or files to other rules. However, if the Agent cannot match a file to a locked rule, the Agent compares
the file to user-created rules. If the file matches a user-created rule, the Agent stops comparing that file
with additional rules. If the file does not match a user-created rule, the Agent continues to compare the
file to unlocked rules. If the files does not match an unlocked rule, the Agent does not include the file in
the back up.

The following figure shows the logic that the Agent follows to process rules:

Locked Rules ? User -created rules ? Unlocked rules ?

Yes

Apply locked rules .

No No

Yes

Apply user -created 
rules .

Apply unlocked 
rules .

No

Yes

File

Do not consider 
the file for backup .

For example, a user creates a rule that excludes all .mp3 files from backup. During a scan, the Agent
compares the user’s files against all of the locked rules in the rules set and finds no rule that pertains to
.mp3 files.

The Agent then compares the user’s files to the user-created rules. The Agent finds a rule that excludes
all .mp3 files from backup. The Agent drops all .mp3 files from the backup list. The Agent then finds an
unlocked rule that includes all .mp3 files in the backup. Because user-created rules take precedence
over unlocked rules, the backup excludes .mp3 files.

The Agent uses the following process to determine which files to select for backups:

1. The Agent determines which volumes to exclude from the backup set.

Users can use the Agent interface to exclude volumes from backup. The Agent does not scan
these excluded volumes. Excluded volumes do not show up on the Backup Set tab in the Agent
User interface.

2. The Agent tries tomatch files to rules based on rule type.

The Agent examines rule types in the following order:
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a. Locked rules

b. User-created rules

c. Unlocked rules

3. When the Agent scans the hard drive, the Agent tries to match files to the list of rules under each
rule type.

The Agent examines the first rule in the list of files for each rule type. It compares the rule
definition to the file location, name, and type.

If the file does not match this rule, the Agent examines the next rule in the list. The Agent
continues this process until it finds a rule that matches the file. After the Agent finds amatching
rule, it uses the rule category type to classify the file as user-created files, application or system
files, or an excluded file. Based on the rule type and how you configure the Agent, the Agent
selects or does not select a file for backup.

If a file does not match any rules, the Agent does not consider the file for backup.

Rule precedence

Assume that you want to create a set of locked rules that cause the Agent to select most files with a
.doc extension for backup and not select files that start with the letter x. The following figure illustrates
how the order of rules results in different behaviors:
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Rule categories

Rule categories determine whether the Agent considers files for backup. For more information, see
Support Center Help. The following table describes each rule category:

Rule Category Description

User-Created Files Include user-created files, such as spreadsheets and documents, in
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Rule Category Description

rules backups.

Exclusion rules Exclude files from backups.

NOTE:
If you exclude a file from a backup, you cannot retrieve it.

Create rules

You can create rules in the following ways:

l Use the Agent Rules Wizard in the Support Center to modify a default rule set and save it under a
new name.

l Use the Agent Rules Wizard in the Support Center to create a new rule set without using a default
set as a template.

l Use the Agent User interface.

Best practices for creating rules

When you create rules, consider the following best practices:

l Consider the types of files that you want to select for backup, and determine which rule category
applies to the files. For example, you want the Agent to back up all .mp3 files. Because .mp3 files
are files that users create, youmust create User-Created Files rule to include .mp3 files in backups.

l Do not rely on the absence of a rule to exclude a file from backup. To exclude files from backup,
create an exclusions rule to specify the exclusion. For example, assume you are a technician who
wants to exclude all .mp3 files from backups. Because the Agent does not consider files for backup
unless the file matches a rule, you decide that you can exclude .mp3 files from backup if you do not
create a rule for them. However, a user creates a rule that specifies .mp3 files for backup. As a
result, the Agent backs up the user’s .mp3 files. To ensure that the Agent does not back up .mp3
files, create a locked exclusions rule.

Use rule sets

Rule sets are collections of rules. You can create rule sets for different organizations, locations, or
types of computer users. For example, you create a rule set for Corporate Engineering that specifies
which files you want the Agent to back up and which files you want the Agent to exclude. Every Agent
contains default rule sets. You can use the default rule sets as they are or as a starting point to create
custom rule sets.
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Rules page

After you open the Agent Rules Wizard in Support Center and enter general properties for a rule set,
you can enter rule definitions in the Rules page. The following figure is an example of the Rules page:

The following table lists the elements in the Rules page:

Element Description

Locked Rules tab. Lists rules that the Agent evaluates before all other types of rules.
Users cannot use the Agent interface tomodify locked rules.

Unlocked Rules tab. Lists rules that the Agent evaluates after it evaluates locked rules
and user-created rules. Users cannot use the Agent User interface tomodify unlocked
rules, but they can create user-created rules that override unlocked rules.

Rules list. Lists the rules for the selected rule type.

Rule editing buttons

l New. Opens the New Rule window. Use this window to specify the details for the new
rule. When you save the rule, the Rules wizard places the new rule at the end of the
list.

l Edit.Opens the Edit Rule window. Use this window to change the details of an
existing rule.

l Convert to Custom. Lets you create a copy of a built-in rule that you canmodify.
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Element Description

l Cut. Lets you remove rules from the current rule set and put them in the Support
Center clipboard. You can paste these rules into another rule set.

l Copy. Makes a copy of the selected rules and puts them in the Support Center
clipboard. You can paste these rules into another rule set or move a group of rules to a
different location in the current rule set.

l Paste. Puts the rules in the Support Center clipboard into the current rule set.

l Remove. Permanently deletes a rule from the current rule set. Support Center does
not put the rule in its clipboard.

Details of selected rule. The rule definitions that the Agent uses tomatch rules with
files. The Agent uses the Category detail to determine which files to select based on the
backup type.

Rule set buttons
l Back. Opens the Rule Set - General page.

l Next. Not used on this page.

l Finish Rule Set. Saves the current rule set. The Rules wizard displays this button if
you have permission tomodify the rule set.

l Close. Closes the window.

Use the Agent Rules wizard

To create, edit, or remove rule sets and rules, use the Agent Rules wizard. For more information, refer
to Support Center Help.

To use the Rules wizard

1. Log on to Support Center.

2. Select a community where you want to create or edit a rule set.

3. Expand theConfigurations node and expand theMac subnode.

4. Complete one of the following tasks:

l To create a new rule set

a. In the left pane, select Agent Rule Sets.

The Create Rule Set page of the Rules wizard opens.

b. Use the Rule Set - General page to specify a name for the rule set and the volumes that
you want the Agent to exclude.
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l Tomodify a rule set

a. Expand theAgent Rule Sets node and select the rule set that you want to modify.

The View Rule Set page of the Rules wizard opens.

b. Save the rule set under a different name, and then follow the Rules wizard to edit or
remove rules in the rules list.

5. To save all of the new ormodified rules in the rule set, click Finish Rule Set.
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Chapter 5: Agent security features

This chapter explains how the Agent security features ensure that unauthorized users do not intercept
and decode files while they travel between the Agent and the Data Center.

l Encryption, below

l Access Control List management, below

l Unauthorized access prevention, below

Encryption

When you register an Agent, the Agent generates an encryption key (a random alphanumeric string)
and stores it locally on the Agent host computer. The Agent does not store the encryption key in clear
text. Instead, the Agent applies 128-bit Advanced Encryption Standard (AES) encryption to the key.
You cannot change the level of encryption that the Agent uses to encrypt the key.

During Agent registration, the Agent uses Secure Sockets Layer protocol (SSL) to securely transmit
the encrypted key to the Data Center. The Data Center escrows the key, in encrypted format, on its
Data Center server so that you can recover the key if you need to fully recover the Agent account.

Before the Agent performs a system backup, it uses the encryption key to encrypt the files in the
backup set. This ensures that hackers cannot intercept and decode the files while they travel between
the Agent and the Data Center during the backup. The files remain encrypted on the Data Center.
When the Agent initiates a retrieval, the Data Center sends the encrypted files to the Agent. When the
Agent receives the files, it decrypts them and then downloads them to the client computer. Because
the Agent stores the encryption key locally, only the Agent that encrypted the files can decrypt them.

Access Control List management

Administrators can apply different file permissions and extended attributes to accounts to limit the
access that non-administrative users have to files, folders, and drives. If configured to do so, the Agent
backs up file permissions and extended attributes that are on the client computer and retrieves them
along with the files the user requests.

When Agents retrieve files for computers, they reapply the file permissions and extended attributes so
that only authorized users can view the files. If you have computers in your organization that multiple
users share, the Agent installed on a computer can back up and retrieve files for all of the users.
However, it does not let users retrieve files for which they do not have file permissions.

Unauthorized access prevention

This section describes Agent features that prevent unauthorized access to files.
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Security certificates

To prevent unauthorized access to files during transmission from the Agent to the Data Center, Data
Center Setup embeds a security certificate in the Agent. The Agent uses the security certificate to
authenticate the Data Center server to perform the following tasks:

l Registration

l Upgrade

l Backup

l Retrieve

l Edit Profile

Password protection for retrieval

To prevent unauthorized access, you can require users to supply an account ID and password to
retrieve a file.

When you create Agent configurations, enable password protection for the retrieve feature. If you
enable this feature, users must enter their account password to retrieve files.

For more information, see Support Center Help.

Prevent access to files on a lost or stolen computer

To prevent access to files on a lost or stolen computer

1. Recover the Agent account to a computer that has a name that is different from the lost or stolen
computer.

The Data Center prevents access to accounts frommore than one computer name. Restoring the
account to a replacement computer with a name that is different from the lost or stolen computer
ensures that the account is protected.

2. To allow a computer name change, do the following:

a. Open Support Center.

b. Search for the Agent account.

c. When Support Center displays the search results, click the account number in the Account
column.

d. Select Tools > Allow Computer Name Change.

The Allow Computer NameChange page opens.

e. Click Allow Change.
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This procedure deletes the computer name that is associated with the account. The next time the
Agent runs a backup, the Data Center recognizes that the account moved to a new computer.

3. Restore the account data.

4. Use Support Center to cancel the account from the lost or stolen computer, and remove the old
account data from the Data Center server.
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Chapter 6: Brand product components

This chapter explains how to use Support Center to brand the Agent software, Support Center, and the
Account Management Website.

l Branding overview, below

l Branding options for Agents, on page 59

l Branding options for Support Center, on page 62

l Branding Options for the Account Management Website, on page 63

l Brand product components, on page 64

Branding overview

You can brand the product in the following ways:

l Replace the default Micro Focus product branding with your company branding.

l Display your company branding but retain theMicro Focus logo.

l Remove the default Micro Focus logo so that it is not displayed with your company branding.

You can brand the following product components:

l Agent

l Support Center

l Account Management Website

If you host your Data Center and have access to the top-level community, you can brand the entire
Data Center. If you do not host your Data Center, you can use a technician ID to brand any community
or subcommunity that to which you can gain access.

If you host your Account Management Website, you can brand the entireWebsite.

NOTE:
Branding will unsign the Agent and the security pop-up will appear.

Agent branding options

You can brand the following components in the following ways:

Component Description Branding options

Agent The program that installs the Agent. l Product name

Connected Backup (8.11.5) Page 57 of 125



Component Description Branding options

installation
program

l Default installation folder
where the Agent Setup
executable installs the
Agent software

l Micro Focus logo

Agent User
interface

The application that lets you perform backups,
retrievals, and otherwisemanage your Agent account.
The Agent User interface includes the following
components:

l Agent StartupWizard

l Welcome to the Agent window

l Enter Password dialog box

Used only by accounts that are not mapped to
single sign-on (SSO) accounts. Agent branding
does not affect the corporate sign in page for SSO
accounts.

l Synchronizing screen

l Agent console

l Agent About window

l Product name

l Product logo for the
following components:

o Agent console

o Agent About window

o Micro Focus logo

Desktop
elements

Dock menu for the Agent Application icon l Product name

l Micro Focus logo

Support Center branding pptions

You can brand Support Center in the following ways:

Component Description Branding
options

Sign In
dialog box

The dialog box that lets you enter credentials to sign in to Support Center l Produc
t image

l Micro
Focus
logo

Change
Password
dialog box

The dialog box that lets you change the password that you use to sign in
to Support Center

This dialog box is used only by accounts that are not mapped to single

l Produc
t image

l Micro
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Component Description Branding
options

sign-on (SSO) accounts. Support Center branding does not affect the
corporate sign in page for SSO accounts.

Focus
logo

Application
header

The header that displays at the top of all application pages l Produc
t image

l Micro
Focus
logo

Account Management Website branding options

You can brand the Account Management Website in the following ways:

Component Description Branding options

Account
Management
Website

The web-based application that lets users perform the
following tasks:

l Register a new account and download the Agent
software

l View account information

l Modify profile information

l Recover accounts

l UseMyRoam to retrieve files

l Order backed-up files onmedia

NOTE:
AMWS branding does not affect the corporate
sign in page for SSO accounts.

l Web site name

l Product logo on
theWeb site

l Micro Focus
logo

Branding options for Agents

You can brand the following elements in the Agent User interface:

l Agent installer windows

l Agent user interface
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Branding options in the Installer window

The following figure shows which elements you can brand in the Agent Installer window:

Branding options in the Agent User interface window

The following figure shows which elements you can brand in the Agent User interface.
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Brand the About window

The following figure shows which elements you can brand in the Agent User interface About window.
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Branding options for Support Center

You can brand the following Support Center elements:

l Sign In page

l Change Password dialog box

l Support Center interface

Inherited branding

When you brand a community, all of its subcommunities inherit the branding. However, you can brand a
subcommunity differently than its parent community. For example, you brand a top-level community to
match the corporate branding standards. You can brand a subcommunity under your top-level
community to match the branding standards of a wholly-owned subsidiary of your enterprise.

Brand the Support Center sign in page

The following figure shows which elements you can brand in the Support Center sign in page:

Brand the Change Password Dialog Box

The following figure shows which elements you can brand in the Change Password dialog box:
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Brand the Support Center Interface

The following figure shows which elements you can brand in Support Center:

Branding Options for the Account Management
Website

You can brand the following elements in the Account Management Website:
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l Logos

l Website name

Brand product components

This section explains how to brand Connected Backup product components. It also describes the
requirements for branding graphic elements.

Requirements for Agent graphics

The following table lists the requirements for each graphic element that you can brand.

Branded graphic element Requirements

Product logo in the Agent User interface
(includes the About window)

Format: PNG (Portable Network Graphics).

Size: 330 pixels wide by 60 pixels high.

Background: Transparent or white.

Requirements for Support Center graphics

The following table lists the requirements for each graphic element that you can brand in the Support
Center application:

Branded graphic element Requirements

Product logo in Support
Center

Format: GIF (Graphics Internet Format).

Size: 159 pixels wide by 40 pixels high.

Background: Transparent or white.

Recommendation: Center the logo within the 159 by 40 pixel image
to ensure the appearance is balanced.

Product logo in the Support
Center logon page

Format: GIF (Graphics Internet Format).

Size: 170 pixels wide by 181 pixels high.

Background: Transparent or white.

Recommendation: Include the phrase, “Support Center” as part of
the image.
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Requirements for Account Management Website
Graphics

The following table lists the requirements for each graphic element that you can brand in the Account
Management Website:

Branded graphic element Requirements

Product logo in the Account Management
Website

Format: PNG (Portable Network Graphics).

Size: 356 pixels wide by 69 pixels high.

Background: Transparent or white. For best results,
use white.

Technician account requirements

To use the branding feature, use a technician account that has Apply Branding andManage Digital
Certificates permission enabled.

For more information about setting permissions for technician accounts, refer to Support Center Help.

Start the branding process

To start the branding process

1. Ensure that you have correctly sized image files for each component that you want to brand.

The image files for the Agent must be in PNG format. The image files for Support Center must be
in GIF format. The image files for the Account Management Website must be in PNG format. The
Apply Branding page specifies the format that is required for the elements that you can brand.

2. Log on to Support Center. Use a technician ID that has the Apply Branding andManage Digital
Certificates permission enabled.

3. If you use central administration to update deployed Agents, disable it until you verify the
appearance of the branded Agents.

For more information, refer to Support Center Help.

4. Select what you want to brand, for example, the Data Center node (if you have permission to gain
access to this node), or a community that you want to brand, or a community with Agent
configurations that you want to brand.

5. Click Tools > Apply Branding.

The Apply Branding page opens.

6. Enter the required information and click Apply.

Support Center displays the followingmessage:
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Community Successfully Branded. New branding settings were applied to
the community. Any subcommunities without customized branding will
use this community's branding. The dctomcat service can now be
restarted to see any changes to Account Management branding,
otherwise branding changes will refresh automatically in five
minutes.

7. To close themessage, click OK.

For more information about how to use the Apply Branding page, see Support Center Help.

NOTE:
To brand Agents that are already deployed, youmust perform one of the following
procedures:

l Use Support Center to enable Central Administration. When you change the branding of
an Agent community, the next time an Agent in the community synchronizes with the
Data Center during a backup, the Agent receives the new branding. For more
information, see Installing Agents.

l Use the Agent Installation command-line interface to upgrade Agents with an Agent
Setup file that contains new branding. For more information, refer to Installing Agents.

Gain access to branding communities

If you brand Support Center at the Data Center level (if you host your Data Center), log on to Support
Center to view your customized branding.

If you brand a community, use the URL for the branded community to view your customized branding.
Support Center displays this URL after you brand a community and at the top of the Apply Branding
page.

NOTE:
Sign in to Support Center as technician for the community that you want to brand, and not as a
technician for the root community.

AdministeringMac Agents
Chapter 6: Brand product components

Connected Backup (8.11.5) Page 66 of 125



Chapter 7: Deploy Account Management
Website

This chapter explains how to deploy and use the standard Account Management Website. If you plan to
create a customWebsite, seeAccount Management Web Services Development.

l Overview of Account Management Website, below

l Deploy Account Management Website, on the next page

l Account credentials, on page 70

l Account Management Website Interface, on page 70

l MyRoam , on page 74

Overview of Account Management Website

Account Management Website lets users download Agent Setup files, manage their account
information, and retrieve files (if you use Support Center to enableMyRoam).

Connected Backup has two types of Account Management Websites:

l Standard Account Management Website. If youmanage your Data Center, you install the
standard Account Management Website when you install the Data Center and Support Center
software.

l Custom Account Management Website. You use the Account Management Web Services and
your development tools to create a customWebsite. For more information, refer toAccount
Management Web Services Development.

If you use a Data Center that another company manages, they must provide you with the URL to gain
access to Account Management Website.

NOTE:
The URLs for Account Management Website are case-sensitive.

The standard Account Management Website includes the following features:

l Account registration

l Agent software downloads

l Profile editing, including user password reset

l Connection to theMyRoam application for file retrieval

l Reinstallation of Agent software for account recovery
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Deploy Account Management Website

To deploy Account Management Website

1. Install the Data Center software on the primary Data Center server.

For more information, see Installing the Data Center.

2. Designate a server to host the Account Management Website software.

For more information about system requirements, refer to Installing the Data Center.

3. To install the standard Account Management Website on the designated server, run Data Center
Setup and select Install Website with MyRoam.

For more information, refer to Installing the Data Center.

For more information about creating a customizedWebsite, refer toAccount Management Web
Services Development.

4. If necessary, edit the terms of use and privacy statements in theWebsite.

5. Create Agent configurations in Support Center.

For more information, see Create Agent configurations, on page 40.

6. If necessary, set the default URL for the Registration and Logon pages.

7. Distribute the Registration URL for theWebsite to users.

Support Center displays this URL on the Edit Agent Configurations page in theMac
Configurations node. When users go to this URL, they can register an account and download the
Agent software.

NOTE:
The URLs for Account Management Website are case-sensitive.

Ensure security

When a user with either native or enterprise directory account credentials connects to the Account
Management Website (AMWS) through aWeb browser and receives account information, theWeb
browser transmits the user’s password to theWeb server unencrypted. Therefore, if you support native
or enterprise directory accounts, ensure that yourWeb server is secure unless you restrict Web access
to a private network. For single sign-on accounts, AMWS does not receive or transmit the user’s
credentials, the third-party identity provider handles all authentication.

Edit the Terms of Use and Privacy pages

By default, the Terms of Use andPrivacy links in the generic Account Management Website display
content. If you host yourWebsite, change the terms tomeet the legal requirements of your company.
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To edit the Terms of Use and Privacy statement

1. Log on to the server where you installed the standard Account Management Website.

2. Go to the following folder:

\Datacenter\apache-tomcat-7.0.42\webapps\ssws\common

3. Use any HTML or text editor to edit the following files:

l policy.html. This page contains the privacy statement content.

l terms.html. This page contains the terms of use content.

Set the Default URL for Registration and Sign In

When you create Agent configurations and Profile andWebsite settings in Support Center, Support
Center generates URLs for the Account Management Website Registration and the standard Sign In
pages. Whether these URLs are resolvable names depends on your network settings. You can use
Data Center Management Console (DCMC) to set the protocol, computer name, and domain name
portions of the URL.

For more information about how to set the URL, refer to DCMC Help.

Set up user access

Users open Account Management Website in the following ways:

l Enter the URL of the sign in page in aWeb browser.

After you install the Account Management Website, send the URL of theWebsite to your users.
Support Center displays the default Website URL in theGeneral page of theProfile and Website
Settings. You can use the default URL or you can specify a URL of a different Web server.

NOTE:
The URLs for Account Management Website are case-sensitive.

l In the Agent User interface, click Tools > Account Online.

To enable this option, configure the Agent to allow access to the Account Management Website
from the Agent User interface.

To sign in to Account Management Website, users must enter their Connected Backup account
credentials. For more information, see Account credentials, on the next page.

Set up technician access

Technicians can gain access to the Account Management Website from the Account Summary page in
Support Center. When technicians click the link to Account Management Website from the Account
Summary page, they sign in as the account user and can use the same features as the user. Only
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technicians with permission to access users’ data have access to the link. For more information about
how to specify technician permissions, see Support Center Help.

Account credentials

During registration, Account Management Website (AMWS) prompts for Connected Backup account
credentials. Which of the following types of credentials a user enters depends on the type that his or her
community uses:

l native Connected Backup account credentials. The user enters an e-mail address and password
to register his or her account. AMWS also prompts for user profile information and stores it along
with the credentials in the user’s profile.

l enterprise directory credentials. The user enters the credentials for his or her enterprise directory
account. AMWS loads account information from the enterprise directory and stores it in the user’s
profile. However, it does not store the enterprise directory account credentials.

l single sign-on (SSO) credentials. The user enters the credentials required by his or her single
sign-on network account. AMWS does not load or store account information or credentials from the
SSO network account.

To sign in to AMWS after the registration process, users must enter their credentials. Users can
specify the same account credentials for more than one account. If they do, after they sign in, AMWS
prompts them to select which account to access. Users can sign in to and view only one account at a
time.

Account credential management

Connected Backup provides two ways to update the credentials of users in a community that uses
native Connected Backup accounts:

l Users canmodify their own credentials through Account Management Website

For more information about how to edit profiles, refer to Account Management Website Help.

l Technicians canmodify a user’s credentials through Support Center.

For more information about how to set passwords and change the contact information, refer to
Support Center Help.

However, Connected Backup does not support credential management for users in a community that
maps accounts to either an enterprise directory or single sign-on accounts. Tomodify credentials for
these types of accounts, users must either contact their system administrator or change the values in
their enterprise directory or SSO system.

Account Management Website Interface

The standard Account Management Website displays the followingWeb pages:
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l Welcome

l Registration

l Sign In

l Summary

Because you can customize any page in the web site, your website might be different from the
examples in this section.

Welcome page

The following figure shows theWelcome page that users see when they open the Account
Management Registration URL.

Registration page

The following figure shows the Registration page that users with native Connected Backup accounts
see when they start the registration process.
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Sign In page

The following figure shows the standard Sign In page. Users with native Connected Backup credentials
or enterprise directory credentials see this page when they go to the Account Management Website
URL after they register and install an account.

AdministeringMac Agents
Chapter 7: Deploy Account Management Website

Connected Backup (8.11.5) Page 72 of 125



For users who access their Connected Backup account using SSO credentials, Account Management
Website displays their corporate SSOSign In page. If for some reason AMWS does not automatically
display the SSOSign In page, users can do the following to display it:

1. Click SSO Sign In page.

2. Type the unique SSOProvider ID that Connected Backup uses to identify the corporate Identity
Provider (IdP) for the user’s account, and then click Go.

If the user does not know this ID, they should contact their system administrator.

Summary page

The following figure shows a typical Summary page that users see after they sign in to the Account
Management Website. The exact options available depend on the Agent configuration and Connected
Backup account of the user.
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MyRoam

MyRoam lets users retrieve backed-up files to any computer without using the Agent User interface. To
access MyRoam, a user must sign in to Account Management Website. After the user selects files to
retrieve, the Data Center creates a ZIP archive file that contains the selected files. The user downloads
this file, and then extracts it to a location on his or her computer.

NOTE:
Users cannot retrieve files if the ZIP archive file is larger than 2GB. If MyRoam determines that
the ZIP will be larger than 2GB, it prompts the user to clear some files from the retrieval set, and
then try to retrieve files again.

If you initiate the retrieval from a computer with a different type operating system than the computer on
which the Agent account resides, the Data Center creates a ZIP file that contains only the files that you
selected. The ZIP file does not retrieve themetadata associated with the files.

If you initiate the retrieval from a computer that runs the same type operating system as the computer
on which the Agent account resides, the Data Center creates a ZIP file that contains the following files:

l MyRoam_Expander file

l A message file

l A data file

TheMyRoam_Expander file is an executable file that retrieves your files along with metadata that is
associated with the files.
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For example, if you use Safari on aMac computer to download files from an Agent account on a
Windows computer, the Data Center creates a ZIP file that contains only the files that you selected for
retrieval. If you use Safari on aMac computer to download files from an Agent account on aMac
computer, the Data Center creates a ZIP file that contains the files that you selected for retrieval and
theMyRoam_Expander executable file. You extract the contents of the ZIP file, and then double-click
MyRoam_Expander.

To access MyRoam, users must log on to Account Management Website.

License and permission requirements

To let users useMyRoam, enableMyRoam in the Support Center. You can enableMyRoam in your
top-level community. You also can enable or disable MyRoam in individual subcommunities and for
individual accounts.

You can enableMyRoam in one or more communities under the following conditions:

l If you host your Data Center, you need to install a license for MyRoam on the Data Center server. If
your current license file does not includeMyRoam, contact your sales representative to buy this
license.

l To enable theMyRoam feature in a community, your technician account must havePermission to
Allocate Licenses to Sub-communities enabled.

l To enableMyRoam for specific Agent configurations, your technician account must haveModify
Agent Configuration enabled.

MyRoam installation

TheMyRoam installation is part of the Account Management Website installation. To install MyRoam,
run Data Center Setup and select Install Website with MyRoam. For information on how to install
software on the Data Center server, refer to Installing the Data Center.

Enable MyRoam

Youmust enableMyRoam for each community and each configuration in the community that needs
access to this feature.

To enable MyRoam

1. Sign in to Support Center. Use a technician ID that has the Allocate Licenses to Sub-
Communities and Modify Agent Configurations permissions enabled.

2. Select the community where you want to enableMyRoam.

3. On the Community Status page, click Manage Features.

4. On theManage Features page, locate the row for theMyRoam feature, and then in theSettings
column, click Enabled.
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5. Click Save.

6. Expand theConfigurations node.

7. Expand theProfile and Website Settings node and select the configuration for which you want
to enableMyRoam.

The Edit Profile andWebsite Settings - General page opens.

8. Select Options.

The Edit Profile andWebsite Settings - Options page opens.

9. In the Account Management Options section, select Allow end users to retrieve files using
MyRoam.

10. Click Finish.

Enable MyRoam for individual accounts

After you enableMyRoam at the community and configuration level, you can enable it for individual
accounts or account groups.

To enable MyRoam for one or more accounts

1. Sign in to Support Center. Use a technician ID that has theModify Agent Configurations
permissions enabled.

2. Search for an account or create an account group.

3. Select Tools > Change MyRoam State.

4. Select the check box to enableMyRoam, and then click Save.
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Chapter 8: Agent interfaces

This chapter explains the interfaces that you can use to install and configure Agents.

l Overview of the Agent interfaces, below

l Agent Startup wizard, on the next page

l Agent User Interface, on page 81

l Agent command-line interface, on page 84

Overview of the Agent interfaces

The Agent includes the following interfaces:

Agent Startup
Wizard

A graphical interface that opens when users start their Agents for the first time
installation. For more information, see Agent Startup wizard, on the next page.

Agent User
interface

A graphical interface that you use to perform the following tasks:

l View a summary of themost recent backup results and the configured
backup schedule.

l View and specify files in the backup set. The backup set contains the files
you selected for back up.

l View and add rules to the Agent rule set.

l Retrieve files that the Agent previously backed up.

l View a history of Agent events and operations.

For more information, see Agent User Interface, on page 81.

Installation
command-line
interface

A command-line interface that you use to perform the following tasks:

l Install an Agent

l Remove an Agent

l Recover an Agent

l Upgrade an Agent

For more information, refer to InstallingMac Agents.

Agent command-
line interface

A command-line interface that you use to perform the following tasks:

l Activate Agents

l Update account profiles

For more information, see Agent command-line interface, on page 84.
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Agent Startup wizard

The Agent StartupWizard is a graphical interface that, if enabled, guides users through set up or
recovery of Agent accounts. The Agent StartupWizard runs under the following circumstances:

l Technicians or users run the msiexec tool to perform the following tasks:

o Install a native account with the StartupWizard enabled in Support Center.

o Install any type of account using an invalid value for the RESERVATIONCODE parameter.

o Install an enterprise directory account without using the LDAPID parameter or specifying an
invalid LDAP account for it.

o Install a single sign-on account in non-silent mode (/qr or /qf verbosity).

l Users start an Agent from a disk image that was installed with the msiexec tool’s
DISKIMAGE=serviceon parameter.

The technician who creates the disk imagemust create one with a running daemon (). For more
information, refer to InstallingMac Agents.

l Technicians or users activate an Agent installed with the msiexec tool’s DISKIMAGE=serviceoff
parameter, as follows:

o Use the activate commandwith the -registernow parameter on a native account that has the
StartupWizard enabled for it through Support Center.

o Use the activate commandwith the -registernow parameter for an enterprise directory or
SSO account without also specifying the -ldapid or -accountuid parameter, respectively.
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Startup Wizard main pages
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Startup Wizard – Create Account option
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Startup Wizard – Recover Account Option

Agent User Interface

You use the Agent user interface to perform the following tasks:

l View a summary of themost recent backup results and the configured backup schedule.

l View and specify files in the backup set. The backup set contains the files you selected for backup.

l View and add rules to the Agent rule set.

l Retrieve files that the Agent previously backed up.

l View a history of Agent events and operations.
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Agent Main window

The following figure shows themain window that the Agent displays when you open the Agent:

Agent user interface components

The following table describes the components of the Agent user interface.

Component Description

Tabs l Summary. Displays a summary of the results of the last backup
and the backup schedule.

l Backup. Lists the files that the Agent selects for backup. You can
select or clear files in this panel.

l Retrieve. Displays a list of files that you can retrieve. You can
select one or more files for retrieval.

l History. Displays event messages.

For more information, see the online Help for each tab.

Connected BackupMenu l About Connected Backup. Displays the software version
number and copyright information.

l Preferences. Lets users perform backups over dial-up
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connections and change the backupmode to either passive or
aggressive.

l Services. Lets you use features of other applications without
opening the applications themselves.

l Hide Connected Backup. Hides the application window.

l Hide Others. Hides all application windows other than the one
that is selected.

l Show All. Shows all open application windows.

l Quit Connected Backup. Closes the application.

File Menu l Back Up Now. Lets you start a back upmanually. The Agent
backs up all new or changed files in the back up set.

Tools Menu l Backup Schedule. If you configure the Agent to let users edit the
backup schedule, this option lets users change the dates and
times when backups occur.

l Advanced Rules. If you configure the Agent to let users edit the
backup set, this option lets users select options in the Backup
Set tab.

l Edit Profile. If you configure the Agent to let users update their
profiles, this option lets users enter information in theEdit Profile
window.

l Manage Account Online. If you configure the Agent to include
this link, the link lets users gain access to their account
information in the Account Management Website from the Agent
User interface.

HelpMenu Connected Backup for Mac Help. Displays a list of available help
topics.

Help buttons Display information about the Agent interface.

Use the Agent user interface

The following table explains how to use the Agent user interface:

Goal Action

Select an Agent
function

Click the appropriate tab to perform the following tasks:

l Select or clear files in the backup set.

l Retrieve files.

l View the Agent History of events.
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Goal Action

l View a summary of themost recent backup.

Gain access to
online help

To open the Agent help, on the Agent mainmenu, click Help > Connected
Backup for Mac Help.

For information about an open tab or window, click the questionmark (?) in the
tab or window.

Agent command-line interface

When you install the Agent software, Agent Setup program also installs the Agent command-line
interface. You can use the Agent command-line interface to perform the following tasks:

l Activate Connected Backup Agents from a disk image.

l Back up files.

l Retrieve files that the Agent previously backed up.

l Get Agent configuration data.

The following table lists the commands that you can use and where to find additional information about
them.

Command Purpose Reference

cbactivate Activates an Agent that an administrator installed from a
disk image.

InstallingMac Agents

cbbackup Initiates an unscheduled backup. This command is similar to
using Backup Now in the Agent User interface.

File backup, on
page 86

cbretrieve Retrieves one or more files from the Data Center or from an
account image.

File retrieval, on
page 97

cb
updateprofile

Updates registration fields according to settings that you
specify in an XML file.

Use the UpdateProfile
Command, below

Use the UpdateProfile Command

The UpdateProfile command causes the Agent to update the registration information stored on the Data
Center server with information that you specify in an XML file.

NOTE:
The UpdateProfile command does not support accounts that aremapped to an enterprise
directory or use single sign-on credentials.

The UpdateProfile command uses the following syntax:
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cbupdateprofile -f[ile] filename

[{-help | -?}]

Where filename is the full path name to the XML file that contains registration information.

The following table describes the parameter that UpdateProfile uses:

Parameter Syntax/Description

-f [ile] (Required)

Specifies the path name of an XML file that you create.

Examples:

cbupdateprofile -f "/filename.xml"

Where

filename is the name of the XML file that contains registration information.

The following example shows how you can use the UpdateProfile command after you
recover an account:

sudo AgentSetup.mpkg/Contents/Resources/install ACCOUNTNUMBER=account_
number TECHID=technician_id PASSWORD=technician_password

cbupdateprofile -f "/filename.xml"

[{-help
| -?}]

(Optional) Displays help for the current command.

For more information on the required fields and themaximum character length for each field in the XML
file, refer to InstallingMac Agents.

The UpdateProfile command requires all of the registration fields.

If you do not specify information for a registration field (for example, you specify
<EmployeeID></EmployeeID>), UpdateProfile clears the field in the Data Center database.

NOTE:
The UpdateProfile command overwrites changes that youmake to these fields with Support
Center.
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Chapter 9: File backup

This chapter explains the process that the Agent uses to upload data from aMac computer to the Data
Center. It also describes the backup settings in Agent configurations.

l The backup process, below

l Back up encrypted files, metadata, and attributes, on page 91

l Backup settings, on page 92

The backup process

The following actions occur during the backup process:

l The Agent scans the host computer’s hard disk and creates a list of files eligible for backup.

l The Agent analyzes the file list to identify any new files or files that have changed since the last
backup.

l The Agent connects to the Data Center.

l The Agent transmits files to the Data Center.

l The Agent records the results of the backup.

NOTE:
The Connected Backup Agent for Mac has a selection and backup limit of 300,000 files.
Selectingmore than 300,000 files for backupmight cause backup errors and performance
degradation.

Disk scan

When the Agent initiates a backup, either in response to a user request or according to its backup
schedule, the Agent scans files on disk drive volumes. The scan excludes removable or network share
drives. If your removable drive presents itself to the operating system (OS) as a fixed drive, it may be
included in the backup set.

NOTE:
A removable drive that meets these requirements must always be connected to your computer
in order for it to continue to be protected. If a backup occurs without the drive attached, the
system will process themissing drive as deselected and will issue delete records for all data
previously protected on this removable drive.

If you use the Agent rule set to exclude specific volumes, the Agent does not scan those drives. If you
exclude volumes that have files that you do not need to back up, you reduce the amount of time that is
required to back up a computer.
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The scan creates a list of the files that are on the computer. The Agent uses the rules in its rule set to
determine which files to select for backup. The backup set for the Agent contains all of the selected
files in the list.

NOTE:
The next backup requires a scan of the entire hard disk under the following circumstances:

l You restart the Agent daemon or the Agent computer.

l The Agent rule set changes.

l The components of the backup set change.

l The files in the backup set have 90,000 or more changes for backup.

File analysis

During analysis, the Agent reviews the list of files it compiled during the scan and determines whether
each file is new, modified, or an exact duplicate of another file on the computer. It also determines
whether the user deleted any previously backed-up files. The Agent then performs the actions
described in the following table:

File type Actions

Base The file is new, and the Agent backed up the file in its entirety. The Agent sends the
entire file for back up and designates it as a base file.

Deleted
Files

The Agent uses file synchronization to notify the Data Center if a user deleted a
previously backed-up file. The Data Center deletes the file after the file expiration rules
determine whether the Data Center retains a file in storage.

DeltaBlock The Agent backs up amodified file from the base file data and saves that file as a delta
file.

MDATE The Agent checks a file modification date (MDATE), size, directory path, and security
descriptors to determine whether a file has changed since the last backup session.

SendOnce If the file has been backed up previously, the Agent does not back up this file because
at least one other account has already backed up the same file. SendOnce technology
prevents multiple copies a file from being stored on the Data Center.

Size The original size of the file in KB, MB, or GB before the Agent applied SendOnce, Delta
Block, or compression.

Symbolic
Link

If the file is a duplicate of another file. The Agent designates a symbolic link to the
duplicate file and does not send the file contents.

Touch The Agent backs up only changes to the file attributes because the data remained the
same.
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Modified file identification

The Agent backs up only new files and the portions of files that changed since the last backup. This
process ensures complete protection of the files and reduces use of disk space on the Data Center. To
determine whether a file changed since the last backup session, the Agent checks the file’s
modification date (MDATE), size, directory path, and security descriptors.

The Agent determines which portions of the file changed by comparing the digital signature of the file
with that of the version on the Data Center. The Agent backs up only the changed portions, or deltas, of
these files.

File preparation

The Agent compresses and encrypts file data before it transmits the data to the Data Center. It uses
the ZLIB compression library to compress both base and delta file data and then uses the encryption
method that you specified when you registered the Agent to encrypt the data.

Connection to the Data Center

The following actions occur when the Agent connects to the Data Center:

1. The Agent uses a network connection to connect to the Data Center. When the Agent contacts
the Data Center, the Agent account number identifies the Agent.

2. After the Data Center authorizes the connection, the Data Center creates an empty archive for the
account and waits to receive files from the Agent.

3. While the Data Center waits to receive files, it downloads a list of expired files to the Agent.

4. The Agent records the file expirations in a local database on the client.

5. The Agent also checks the Data Center to determine which file sets for backup already exist in the
SendOnce pool.

If an exact copy of a file exists in the SendOnce pool, the Agent does not send the file’s content to
the Data Center. Instead, it sends information about the file name and location. The Agent and
Data Center can use this information at a later time to retrieve the file content from the SendOnce
pool to restore the client’s copy of the file.

NOTE:
The Agent initiates connections between the client and the Data Center server. The Data
Center never initiates contact with the Agent client. Even when a technician uses Support
Center to modify an Agent configuration, the Data Center downloads the changes only
after the Agent connects to the Data Center.

Transmission of files

After the Agent connects to the Data Center, it initiates a backup session. The backup consists of the
following tasks:
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1. The Agent transmits the digital signature of the file to the Data Center. The Data Center compares
this signature with other files in its database. If an identical file exists in its database, the Data
Center creates a pointer to the file in the SendOnce pool when it creates the archive for the
backup. The Agent does not transmit the file to the Data Center.

2. If the SendOnce does not contain the file, the Agent uses the ZLIB compression library to
compress the file.

3. The Agent uses an encryption key to encrypt the file. The Agent generates the encryption key.
You cannot view this key.

4. The Agent transmits the compressed and encrypted file to the Data Center.

5. As the Data Center receives the files, it puts them into archives.

For more information, see theProduct Overview guide.

Record of backup results

The Data Center transmits an acknowledgement (ACK) or non-acknowledgement (NACK) for each file
that it receives or fails to receive from the Agent. The Agent uses these receipts to update the Agent
database. To view the results of the backup, view the Agent History in the Agent User interface or
Support Center.

NOTE:
If a backup fails because of a power outage, or a backup daemon fails unexpectedly, the Agent
History indicates the failure but does not provide details.

Outlook for Mac support

The Connected Backup Agent for Mac now supports Outlook 2011 andOutlook 2016 for Mac. To use
Outlook with the Connected Backup Agent for Mac, theMac Agent file set now contains two new rules.
In addition, a new procedure now explains how to perform the restore process when you include
Outlook in your backup set. To use Connected Backup version 8.5.1 or later, youmust restore your
Outlook mailbox.

To restore your Outlook 2011 mailbox

1. Quit all Microsoft applications.

2. Stop theMicrosoft Outlook process. To do so, complete the following steps:

a. Open the Activity Monitor. To do so, click the Activity Monitor icon in the Dock.

b. Locate theMicrosoft Outlook process in the Activity Monitor window, and then click Quit
Process. TheQuit Processwindow opens.

c. Click Quit.

3. Open theMicrosoft Database Utility, which has the following default location:
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Applications/Microsoft Office 2011/Office/Microsoft Database Utility.

4. Double-click the Identity that you want to restore, and then rename the Identity to Identity_old.

5. Open the Connected Backup Agent for Mac, and then select theRetrieve view.

6. In theBacked-up Files pane, locate the Data Records folder for your Identity. The location for the
Data Records folder is Documents/Microsoft User Data/Office 2011
Identities/<identity>/Data Records.

7. Select the Data Records folder, and then click Retrieve. You receive a prompt to select a retrieve
location.

8. Select Original Location > Retrieve.

9. Open theMicrosoft Database Utility. Select the Identity that you want to retrieve, and set this
Identity to Default. To do so, click Action, and then select Set as Default.

10. Click Rebuild. TheMicrosoft Database Utility starts to rebuild the database.

11. During the Rebuild process, theMicrosoft Database Utility creates a new database and a copy of
the Identity. Delete the copy of the Identity.

NOTE:
The following is sample text to help identify the copy of the Identity:

Main Identity: [Backed up 2001 - 3 - 26]

To delete the copy of the Identity, select the copy, and then click theminus (-) button in the
bottom left corner of theMicrosoft Database Utility window. After you delete the copy of
the Identity, close theMicrosoft Utility window.

12. Start Microsoft Outlook. The application restores your local files, and when you reconnect to your
mail server, Outlook 2011 updates your inbox.

To restore your Outlook 2016 mailbox

1. Quit all Microsoft applications.

2. Stop theMicrosoft Outlook process. To do so, complete the following steps:

a. Open the Activity Monitor. To do so, click the Activity Monitor icon in the Dock.

b. Locate theMicrosoft Outlook process in the Activity Monitor window, and then click Quit
Process. TheQuit Processwindow opens.

c. Click Quit.

3. Use File Finder to locate the following location, and then rename theMain Profile folder to Main
Profile.old.

Users/*/Library/Group Containers/*.Office/Outlook/Outlook 15 Profiles

4. Open the Connected Backup Agent for Mac, and then select theRetrieve view.

5. In theBacked-up Files pane, locate the Data Records folder for your Identity. The location for the
Data Records folder is Users/*/Library/Group Containers/*.Office/Outlook/Outlook 15
Profiles/Main Profile/.
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6. Select the Data Records folder, and then click Retrieve. You receive a prompt to select a retrieve
location.

7. Select Original Location > Retrieve.

8. Open theOutlook Profile Manager. Select theMain Profile and set it toDefault. To do so, click
Action, and then select Set as Default.

9. Start Microsoft Outlook. You receive a prompt to repair the application. Click Repair.

10. During the Rebuild process, the Outlook Profile Manager creates a new database.

11. Restart Microsoft Outlook.

12. Go to Outlook Profile Manager, and delete theMain Profile.old profile that you created earlier.

Back up encrypted files, metadata, and attributes

You can back up the following types of files:

Data Description

Encrypted
files

The Agent backs up encrypted files using SendOnce and Delta Block technology. You
must configure your system to use the NTFS file system when you back up encrypted
files.
For encrypted files, the Agent does not back upmultiple data streams, reparse points,
extended attributes, sparse files, or shared file attributes.

Resource
forks

When the Agent backs up files that have resource forks, it also backs up the resource
fork and, therefore, the structured data within the resource fork.

Open files The Agent monitors files for changes at all times, whether the files are closed or open.
If a file changes during the time that the Agent analyzes it for backup or before the
Agent transmits it to the Data Center, the Agent identifies the file to the Data Center as
one that the Agent has to back up again. The Agent also adds the followingmessage to
the Log file:

The Agent could not back up <file_name> in folder <full_
folder_path> because it was modified during backup
processing. Close any applications that may be modifying this
file and try backing up again.

The Agent attempts to back up the file again during the next backup session.

Security
descriptors

Security descriptors prevent unauthorized access to files. Security descriptors include
information such as the following:

l Owner of the file

l Permissions the owner has granted to other users

l Actions that the file system logs for auditing purposes.

If a security descriptor for a file or folder changes, the Agent considers the file or
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directory to be different from the previous version and backs up the security descriptors
for the file or folder. The Agent backs up file content only if the Agent determines that,
in addition to the security descriptors, the content changed.

Sparse
files

Sparse files contain empty spaces (represented as strings of zeros) along with
meaningful data (nonzero data). The file system allocates disk space for the
meaningful data but does not allocate space for the nonmeaningful data (the strings of
zeros). The file system tracks where the nonmeaningful data belongs. When an
application retrieves a file, the Agent can retrieve the data and the strings of zeros.
The Agent backs up all allocated blocks in a sparse file. It does not back up the
unallocated block. When an application connects to the file, the correct data is
available.

CAUTION:
Do not include the TimeMachine folder in your backup set. If you do, the backup process uses
all available memory.

Backup settings

When you use Support Center to create or modify an Agent, you select backup settings that suit the
unique needs of your users. The following table describes the backup settings:

Backup Settings Descriptions

Backupmode You can specify one of the following backupmodes:

l Passive. The Agent does not retry backups that cannot
start because of the following conditions:

o Errors.

o The Agent is busy doing a retrieval.

o The computer cannot connect to the Data Center.

Under these circumstances, the Agent waits for the next
scheduled backup, or for a user to initiate amanual backup.

l Aggressive. The Agent retries backup periodically until a
successful backup occurs. If a backup attempt generates
warnings or errors, the Agent does not retry backup.

Backup limits You can limit the size of the backup set for each Agent
configuration.

You can limit the size of backups in the following ways:

l On the Agent computer, set a size limit of the backup set
in megabytes or gigabytes. For example, you can set the
backup set size limit to 30GB.
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l Configure the Agent to display a warningmessage when
the backup set reaches a specified percentage of its limit.
For example, you can configure the Agent to display a
warning when the backup set size is 90% of the allowed
size limit.

Backup permissions You can configure Agents to let users have the following
permissions:

l Modify their backup sets. If you enable this permission,
users have access to user-configurable backup options
such as the backupmode settings.

l Allow backup over dial-up connections.

l Let users edit their backup schedules in the Agent User
interface.

Backup schedule You can select one of the following backup schedules:

l Automatic on specific days and times (default). Starts
a backup during the same time period each day. For
example, the Agent can perform a backup each night
betweenmidnight and 6:00 A.M. You can select only a
range of time and not an exact time for the backup. The
Agent determines when to perform the backup within the
range that you specify. This behavior balances network
traffic.

l Manual backup. Starts a backup only when a user
initiates it.

Agent rule sets To determine which files to select for backup, create rule
sets. To create rule sets, use the Agent Rules wizard in
Support Center.

New Agent installations include configured rules. If you
change the rules, the Agent receives the changes the next
time that it connects to the Data Center.

Users can create rules that override some rules in an Agent’s
default rule set. You can create overriding rules in the
following ways:

l Select or remove files on the Backup Set tab in the Agent
User interface.

l Use the Advanced Rules option to create rules.

For both options, users must have permission tomodify their
backup sets, which you set in the Agent Settings component
associated with the Agent configuration.

For more information about rule sets, see Create Agent rule
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sets, on page 46. For more information about how to create
rules, refer to Support Center Help.

Use the Agent user interface to back up files

You can use the Agent User interface to start a backupmanually, specify which files are in the backup
set, or monitor a backup in progress.

The Agent configuration that you create in Support Center determines how the Agent backs up data.
The configuration includes all of the backup settings and versions for the Agent.

For more information about how to create Agent configurations, refer to Support Center Help.

Backup Set tab

You can use the Backup Set tab to change the file selection for the backup set or start a backup
manually. For more information, refer to Agent Help.

Summary tab

You can use the Summary tab to start a backup and view History details about the last backup that
the Agent performed.

Backup monitoring

If you configure the Agent to use a predetermined schedule, you do not need to open the Agent User
interface. The Agent scans the system’s hard disk and identifies which files to back up.

If you want to monitor progress of a backup, open the Agent User interface while the backup is in
progress. The Agent displays a progress window that indicates the state of the backup. The Agent
disables all other tabs and options. You can check the Agent history to determine the outcome of a
backup that is complete.

The following figure shows the Agent User interface while a backup is in progress:
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Back up files using the Backup command

Rather than wait for a scheduled backup, you can use the Backup command from the Agent command-
line interface to start a backup. This command is equivalent toBackup Now in the Agent User
interface.

The Backup command backs up files based on the backup settings in the Agent configuration. You
cannot use the Backup command to specify a specific file for backup.

Also use the Backup command if you use scripts to automate computer management or if youmust
manage computers from remote locations.

For more information about how to gain access to the Agent command-line interface, see Agent
interfaces, on page 77.

Backup command syntax

The backup command uses the following syntax:

cbbackup

[{-firstbackup | -b}]

[{-register | -r}]

[{-endpoint | -e} url]

[-help | -?]
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Backup command options

The Backup command has the following options:

Option Description

[{-firstbackup | - b}] (Optional) Initiates a first backup after you install the
Agent.

[{-register | -r}] (Optional) Performs account registration.

[{-endpoint | -e} url] (Optional) Specifies the service end point. The default
value is http://localhost:16386/.

[-help | -?] (Optional) Displays help for the current command.

Backup command example

The following example is a command that starts the first backup after you install the Agent.

cbbackup -firstbackup

The Agent uses the rules in its configuration to select files for backup.
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Chapter 10: File retrieval

This chapter explains how to retrieve files from the Data Center and frommedia.

l The Retrieval Process, below

l Support for encrypted files, metadata, and attributes, on the next page

l Retrieve files using the Agent user interface, on the next page

The Retrieval Process

The following actions occur during the retrieval process:

1. The Agent connects to the Data Center to initiate a retrieval request.

2. The Data Center receives the request and packages files from one or more archives.

3. The Data Center compresses and encrypts the packaged files, and then downloads them to the
Agent.

4. The Agent decompresses and decrypts the files.

5. The Agent distributes the files to the destination folders, and then applies conflict resolution rules.

File repackaging

Many files that you retrieve havemultiple versions backed up on the Data Center. These backups
contain incremental changes, or deltas, that the Data Center stores in one or more archives.

During a retrieval, the Data Center collects the archives that it needs to reconstitute the requested
version of the files from its server and, if applicable, from its auxiliary storage devices. The Data Center
extracts the required base and delta files from the archives. It thenmerges them to create the file or
files that the Agent requested. Before the Data Center downloads the files to the Agent, the Data
Center compresses and encrypts the files again for security.

E-mail notification

You can configure the Data Center to send an e-mail message to the Agent e-mail address when
anyone retrieves files for an account that is registered in a specific community.

E-mail notification contributes to security. When a technician knows about a file retrieval, the
technician can act appropriately if an unauthorized person retrieves the files.

You enable e-mail notification through Support Center at the Data Center, community, or
subcommunity level. You cannot restrict e-mail notification to specific Agent configurations. You can
enable e-mail notification for the entire Data Center or specific communities. For more information
about how to enable e-mail notification, see Support Center Help.
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Support for encrypted files, metadata, and
attributes

This section describes how Connected Backup supports encrypted files, metadata, and attributes
during file retrievals.

Retrieval of sparse files

During a retrieval, the Agent restores sparse files and all allocated sparse data that was previously
backed up.

Retrieval of resource forks

When the Agent retrieves files that have resource forks, it retrieves the resource forks and the
structured data that the resource fork contains.

Retrieval of open files

The Agent can replace a file that is open with advisory locking at the time of retrieval.

If you try to retrieve a file while it is open with advisory locking, and you selected theOverwrite the
files currently on my computer option, the Agent renames the file that it retrieves from the Data
Center. When the Agent renames files, it adds the word Restored and a number to the end of the file
name.

The Agent also generates an event in Agent History to indicate that it retrieved and renamed the file.
The Agent also writes the followingmessage to the Agent log file:

The Agent could not overwrite file <file_name> because it was open by another
application or process. The file was retrieved as <file_name Restored x>.

Retrieve files using the Agent user interface

When the Agent retrieves files, it uses the Agent account number to authenticate to the Data Center.
The Agent submits the retrieval request to the Data Center and waits to receive the files. For more
information about the Agent User interface, see Agent interfaces, on page 77.

Retrieve tab

The following figure shows the Retrieve tab with a list of retrievable files.

AdministeringMac Agents
Chapter 10: File retrieval

Connected Backup (8.11.5) Page 98 of 125



Retrieve permissions

The Retrieve permissions that you set in the Agent configuration determine whether users need to
provide credentials to gain access to the Retrieve tab. When you create Agent settings, you can
specify one of the following actions:

l Do not require a password to retrieve files.

l Require a password to retrieve files. The password is the password associated with the account.

If you configured the Agent to require credentials, the Agent prompts the user for this information before
it opens the Retrieve tab.

File selection

By default, the Agent’s Retrieve tab lists themost recent versions of files that the Agent created during
the last backup. You can also display You can use these options to retrieve earlier versions of files as
well as themost recent ones.

To select files that you want to retrieve, select the check box next to each folder or file.

For more information about how to select files, see Agent Help.
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Destination options

After you select files to retrieve, the Agent displays the Agent Options window. On the Agent Options
window, you can select any of the following options as destinations for retrieved files:

l New Location. Lets you specify a new location for the retrieved files.

l Original Location. Restores the selected files to their original locations. During the Retrieve, the
Agent adds missing folders as needed to recreate the original locations.

File name conflict options

In addition to using the Agent Options window to select destinations for retrieved files, you can specify
how to rename files in case a file name conflict occurs. You can choose either of the following options:

l Rename the files being retrieved. Renames a file when the destination folder contains a file with
the same name, and adds a number to the end of the file namewhen it renames files.

For example, if you retrieve a file named Report.doc and this file exists in the destination folder,
Retrieve would rename the file to Report1.doc. This option is available only if you select Original
Location.

l Overwrite the files on my computer. Overwrites files on your computer if the retrieved files have
the same name as existing files. This option is available only if you select Original Location.

Retrieve files using the Retrieve command

To use the Agent command-line interface to retrieve backed up files from the Data Center, issue the
Retrieve command.

NOTE:
The Retrieve command does not support single sign-on (SSO) credentials. Therefore, if a user
in an SSO community has an Agent Configuration that requires a password for retrievals, he or
she cannot use the Retrieve command to retrieve files. However, a technician can use the
Retrieve command to retrieve files on the user’s behalf. To do so, the technicianmust use the
Retrieve commandwith a Technician ID that meets the following criteria:

l has native Connected Backup credentials or is mapped to an enterprise directory

l has permission to access the SSO community in which the user’s account resides

After you issue the Retrieve command, the Agent connects to the Data Center and uses its account
number to authenticate. The Agent submits the retrieval request to the Data Center and waits to
receive files.

If a file that the Agent retrieves has the same name as a file in the destination folder, the Agent renames
the file in the destination folder. For more information about how to gain access to the Agent command-
line interface, see Agent interfaces, on page 77.

Use the Retrieve command in the following situation:

l You use scripts to automate computer management or to manage computers from remote locations.
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Formore information about performing command-line installations, see InstallingMac Agents.

Retrieve command syntax

The Retrieve command uses the following syntax:

cbretrieve

{-date | -d} YYYY-MM-DD

{-time | -t} HH:MM:SS

[{-backupdates | -bd}]

(-techid | -id} technician_ID

{-password | -pw} technician_password

[{-destination | -dp} path]

[{-source | -s} source_path | {-alldata | -a}]

[{-norecurse | -nr}]

[{-endpoint | -e} url]

[{-help | -?}]

Retrieve command options

The Retrieve command has the following options:

Option Description

{-date | -d} YYYY-MM-DD (Optional.) The date of the file that
you want to retrieve.
If you do not use the -date or -time
parameters, the retrieve command
retrieves themost recent version of
the files.

If you use -date with -time, you
retrieve files as of the date and time
that you specify.

If you use -date without -time, you
retrieve files as of midnight on the
date that you specify.

{-time | -t}HH:MM:SS (Optional.) The time of the file that
you want to retrieve. Use a 24-hour
time format to specify the time.
If you do not use the -time or -date
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parameters, you retrieve themost
recent version of the files.

If you use -time without -date, you
retrieve files as of the current date
and the time that you specify.

If you use -time with -date, you
retrieve files as of the date and time
that you specify.

[{-backupDates | -bd}] (Optional.) The list of dates and
times of the file that you want to
retrieve. Use a 24-hour time format to
specify the time.

{-techid | -id} technician_ID (Required only as indicated.) The
ID of a valid user or technician that
either has native Connected Backup
credentials or is mapped to an
enterprise directory.
NOTE:
This option does not support
IDs for SSO accounts.

Required only as follows:

l For users, if you run the Retrieve
command from a computer that
hosts an Agent configured for an
account other than your own.

l For technicians, it is always
required. In addition, the technician
account must have permission to
access the community in which
the user’s account resides.

{-password | -pw} technician_password (Required only as indicated.) The
password associated with the user or
technician account ID.
NOTE:
This option does not support
passwords for SSO accounts.

Required only as follows:

l For users, if your Agent
Configuration requires passwords
for file retrieval. However, if it
does, and your account is mapped
to an SSO account, you cannot
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use the Retrieve command to
retrieve files.

l For technicians, it is always
required. In addition, the technician
account must have permission to
access the community in which
the user’s account resides.

[{-destination | -dp} path] (Optional.)Specifies where you want
to put the restored files.
Use the following syntax:

drive:\path

If the original drive does not exist, the
Retrieve command creates the
following path for the retrieved files:

@Drive_n\original_filepath

If you do not specify this parameter,
the command restores files to their
original locations.

[{-source | -s} source_path | {-alldata | -a}] (Optional.) Specifies the files that
you want to retrieve.
You can specify one of the following
options:

l -source | -s:

Specifies the path to the files that
you want to retrieve.

You can use the asterisk (*) and
the questionmark (?) as wildcard
characters. The * wildcard
matches any combination of
characters. The wildcardmatches
any single character.

l -alldata | -a:

Retrieves all data from the backup
specified in the -date parameter.
This parameter is the default if you
do not specify the -source
parameter.

[{-norecurse | -nr}] (Optional.) Tells the Agent not to
retrieve files from lower level
subfolders. Use this option with the -
source or -s option.
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[{-endpoint | -e} url] (Optional.) Specifies the service end
point. The default value is
http://localhost:
16386/.

[{-help | -?}] (Optional.) Displays help for the
Retrieve command.

Examples of how to use the Retrieve command

The following examples show ways that you can use the retrieve command.

Retrieve a single file

This command retrieves a file named myfile.doc from a backup set. The example does not specify a
date or time. Therefore, the command retrieves themost recent version of the files. The example does
not specify a destination parameter. Therefore, the command restores the file to its original location.

cbretrieve -techid supt346 -password 678ioh7 -source /reports/myfile.doc

Retrieve a single file and specify date and time

This command retrieves a file named myfile.doc from a backup set with a date of January 15, 2014
and time of 2:15 a.m. The example does not specify a destination parameter. Therefore, the command
restores the file to its original location.

cbretrieve -date 2014-01-15 -time 02:15:00 -techid supt346 -password 678ioh7 -
source /reports/myfile.doc

Specify a retrieve location

This command retrieves a file named myfile.doc from a backup set with a date and time of January
15, 2014, 2:15 a.m., and saves the file to a folder named
/restore.

cbretrieve -date 2014-01-15 -time 02:15:00 -techid supt346 -password 678ioh7 -
destination /restore -source /reports/myfile.doc

Retrieve files only in a top-level folder

This command retrieves files in a folder named /reports. In this example, the NoRecurse parameter
indicates that the command does not retrieve files in subfolders.

cbretrieve -date 2014-01-15 -time 02:15:00 -techid supt346 -password 678ioh7 -
destination /restore -source /reports -norecurse
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Retrieve all files in a backup set

The command retrieves all files in a backup set with a date and time of January 15, 2014, 2:15 a.m.

cbretrieve -date 2014-01-15 -time 02:15:00 -techid supt346 -password 678ioh7 -
destination /restore -alldata

Retrieve data using MyRoam

MyRoam lets users retrieve backed-up files to any computer without using the Agent User interface.
Users must log on to the Account Management Website to have access toMyRoam. After users
select the files that they want to retrieve, the Data Center creates a ZIP archive file that contains the
selected files. Users download this file and extract it to a location on their computer.

To useMyRoam, the Agent account and the community where the account is registeredmust have
MyRoam enabled.

The MyRoam retrieval process

The process to retrieve files with theMyRoam application comprises the following steps:

1. You select a backup set that includes the files that you need.

2. TheMyRoam application displays a list of files that you can select for retrieval.

3. You select the files that you want to retrieve.

4. The Data Center server creates a ZIP archive file that contains the files that you selected.

If you initiate the retrieval from a computer with a different type operating system than the
computer on which the Agent account resides, the Data Center creates a ZIP file that contains
only the files that you selected. The ZIP file does not restore themetadata associated with the
files.

If you initiate the retrieval from a computer that runs the same type operating system as the
computer on which the Agent account resides, the Data Center creates a ZIP file that contains the
following files:

l MyRoam_Expander file

l A message file

l A data file

TheMyRoam_Expander file is an executable file that restores your files along with metadata that
is associated with the files.

For example, if you use Safari on aMac computer to download files from an Agent account on a
Windows computer, the Data Center creates a ZIP file that contains only the files that you
selected for retrieval. If you use Safari on aMac computer to download files from an Agent
account on aMac computer, the Data Center creates a ZIP file that contains the files you selected
for retrieval and theMyRoam_Expander executable file.
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5. You download the ZIP file to a location of your choice. The ZIP file preserves the folder structure
for the files that you selected. Because the folder structure remains intact, you do not have to be
concerned with file name conflicts as you would if you were to use the Agent interface to retrieve
the files.

NOTE: A pop-upmessage is displayed when you download a file from AMWS (install or
reinstall agent) on the host system. Click Allow to continue with the download.
ClickingCancel disables the download option. Refresh the page. You will not be able to
download the file till you click Allow in the pop-upmessage.
The pop-up is not displayed again, once you click Allow.
Following is an example of the pop-upmessage:
"Do you want to allow download on "Testvm1420.testlab.net"?

6. You extract the contents of the ZIP file, and then run theMyRoam_Expander application, if
included in the ZIP file.

NOTE:
MyRoam has a 2GB data limit. You cannot zip or unzip a file that has an uncompressed
data size that is more than 2GB.

Files that you cannot retrieve

You can retrievemost backed-up files except for e-mail files that the Agent backed up with the
Connected EmailOptimizer technology. Youmust use the Agent User interface to retrieve these files.

You can retrieve encrypted files. However, MyRoam retrieves encrypted files to an unencrypted state.

NOTE:
You can retrievemultistream files. However, theMyRoam application retrieves themain data
stream only.

Select files for retrieval

When you select Retrieve files using MyRoam, theMyRoam application compiles a list of files that
you can retrieve from the Data Center. When the list is ready, theMyRoam application displays a
Browse view that lists the files that your Agent previously backed up. The default view for this page
shows the latest version of each backed-up file.

To select files for retrieval

1. To find the files that you want to select, use one of the followingmethods:

l Browse.

l Use a wildcard search.

l Display specific file versions.

2. Select the check box next to each file that you want retrieve.

3. To start the retrieve process, click Retrieve.
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To browse for files

1. To find specific files to select for retrieval, expand the folders in the left pane of the Browse view.

2. To sort the list of files, click any column heading.

An up-arrow in the column heading indicates that the column is sorted in ascending order. A down-
arrow indicates that the column is sorted in descending order.

To use a wildcard search to find files

1. Click Find.

TheMyRoam application displays the Find options.

2. In theName contains field, enter the full or partial name of the file you want to find.

The names are not case sensitive.

You can use the following wildcard characters in the name:

* Use this character to match zero or more characters. For example, *.doc
matches any file that has a file extension of .doc.

? Use this character to match a single character. For example, ab?.doc
matches abc.doc and aby.doc.

3. In the Look in folder box, enter the full path for a folder that you want to search, or select a folder
in the left pane.

Find searches all folders within the folder that you specify.

TIP:
The default location for the Look in folder box is the folder selected in the left pane. To
change the folder location, select a new folder in the left pane.

4. Click Find Next.

In the list below the Find options, the Agent highlights the first file or folder that it finds.

5. Do one of the following:

l Click Find Next or use the arrow buttons to highlight the next folder or file that matches the
Find criteria.

l Click Find Previous or use the arrow buttons to highlight a previously found file or folder.

6. From the displayed list, select the file that you want to retrieve.

7. To hide the Find options, click X in the upper right corner of the Find pane, or click Browse.

In theShow field, the Agent displays the list of files that match the criteria.
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To display different file versions

1. To change the file versions that are displayed in the Browse view, select an option from theShow
versions list. The list includes the following options:

l Most Recent. Lets you display the backed up files that were on your system at the time of the
recent backup. This is the default selection.

l As of Backup Date. Lets you display the backed up files that were on your system at the time
of the selected backup date.

l All. Lets you display all versions of the files that are currently stored on the Data Center server.

2. If you selectedAs of Backup Date, select a backup date from the displayed list and click OK.

Retrieve files

After you select the files that you want to retrieve, you are ready to download the selected files.

To download the selected files

1. In theMyRoam Browse view, click Retrieve.

TheMyRoam application displays information about the total size of the files that you select for
retrieval and the estimated download times for each file. It also includes instructions on how to
download the ZIP archive file or Mac executable file that contains your retrieved files.

2. Select the type of file that you want the Data Center to generate:

a. Zip file. Restores data only.

By default, if you initiate the retrieval from a computer with a different type operating system
than the computer on which the Agent account resides, the Data Center creates a ZIP file that
contains the files that you selected for retrieval. The ZIP file does not restore themetadata
associated with the files.

If you initiate the retrieval from a computer with a different operating system than the computer
on which the Agent account resides, do not select this option.

b. Executable. Restores data andmetadata.

By default, if you initiate the retrieval from a computer with the same type operating system as
the computer on which the Agent account resides, the Data Center creates a ZIP file that
includes theMyRoam_Expander file. This executable file restores your files along with
metadata that is associated with the files.

3. Click Download.

4. In the File Download box, click Save.

5. In the Save As box, specify a location for the ZIP file, and click Save.

6. Do one of the following:
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l If the ZIP file is a standard one that contains the files that you selected for retrieval, extract the
contents of the ZIP file to where you want them on your local computer.

l If the ZIP file contains the MyRoam_Expander.exe file, extract the contents of the file to a
temporary location, and then do one of the following to run theMyRoam_Expander application
to restore your files:

o On computers that runWindows XP, double-click the MyRoam_Expander.exe file.

o On computers that runWindows 7 orWindows 8, right-click the MyRoam_Expander.exe file,
and then click Run as administrator.

The program restores the files to the root of the directory that contains the MyRoam_
Expander.exe file.

To use MyRoam to retrieve files

1. Log on to the Account Management Website:

2. Select Retrieve Files with MyRoam.

3. Select the files that you want to retrieve, and then click Retrieve.

TheMyRoam application creates a compressed archive file (ZIP file) that contains all of the
selected files.

NOTE:
MyRoam has a 2GB data limit for creating zip files. You cannot zip or unzip a file whose
uncompressed data is more than 2GB.

4. Click Download to download the compressed ZIP file.

For more information, seeMyRoam Help.
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Chapter 11: Agent history and reports

This chapter explains how to view Agent History and Support Center reports to monitor Agent activity.

l Agent history, below

l Support Center reports, on page 113

l Use the Agent Protocol Session log, on page 117

Agent history

Use the Agent History to verify successful Agent activity or diagnose a potential problem. The Agent
History lets you view details about the following events:

l Account recovery

l Account registration

l Backup

l File list synchronization

l Retrieve

The Agent records details about activities and interactions with the Data Center in a file that you can
view on the Agent User interface History tab.

Each event entry contains the following information:

l The type of activity

l The outcome of the event

l The date and time that the activity started and ended

You can export the list of events to XML files that you can send to a technical support representative.

View Agent history in the Agent interface

View Agent history from the History tab in the Agent interface.

To view Agent history from the Agent interface

1. Open the Agent interface.

2. Click the History tab.

The History window opens.
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To export the list of events on the History tab to a file

l Click Export.

The following figure shows the History tab:

You can view details about a specific event, and export the details to a file.

To view details about an event

1. Open the Agent interface.

2. Click theHistory tab.

The History window opens.

3. On the History window, select an event.

4. Click View.

The View History Details window opens.

5. Optionally, to save the details to a file, click Export.

The following figure shows an example View History Details window:
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Formore information, see Agent Help.

Viewing Agent History in Support Center

You can use Support Center to view the same list of events that you view in the Agent History tab in
the Agent User interface. When you select one or more events, you can display detailed information
about each event.

You can also view export details in an export file. If you enable diagnostics for the account, Support
Center displays the diagnostic information in the Agent History view. You can export the content to a
file that you can e-mail to a technical support representative.

For more information, see Support Center Help.

To view Agent History from Support Center

1. Open Support Center.

2. Search for the account for which you want to view the Agent History.

3. Click Tools > View Agent History.

The View Agent History page opens. The following figure shows an example of the entries in the
View Agent History page:
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4. To display the details for a particular event, select the event and click View.

5. To export the details to a TXT or XML file, click Export.

The Export dialog box opens.

6. Browse to the location on your computer where you want to store the details .txt file, and click
Save.

The Support Center names the file AgentLog_account_number.txt, where account_number is
the number associated with the Agent account.

7. To close the View History Details page, click Close.

Support Center reports

You can use Support Center to report on the accounts on your Data Center. You can perform the
following tasks:

l Run default reports installed with Support Center.

l Create and edit your own reports.

l View and display charts.

l Save and export reports in XML format.

l Create account groups.
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Default reports

Support Center includes a default set of report templates. You can edit a default report template tomeet
your needs. If you do this, save the edited default report template under a new name. Doing so ensures
that you do not lose the original default configuration and that Support Center upgrades do not overwrite
your customizations.

For example, a future version of Support Center has updated default report templates. When you
upgrade Support Center, you overwrite the original default versions. The following tables describes the
default report templates that are installed with Support Center:

Support
Center
report
template

Description

Account List A list of accounts in Support Center. Support Center sorts the list by community,
then by account name.

Account Size The amount of data that each account on the Data Center stores.

Account User
Log Errors

The information on accounts that have failed to backup one or more consecutive
times, and the type of error it encountered.

Accounts Not
Backing Up

A list of PC accounts that the Data Center has not backed up for at least 10 days.

Activity
Trends

A graph that shows the trends in the backup activity of accounts. The graph shows
data in gigabytes (GB) backed up per day.

Backup
Activity

A list of accounts by community, and the amount of data backed upmonth to date.

Configurations The assigned and actual Agent configurations for each account.

Data Access
by
Technicians

Information about which technicians accessed a specific account and the type of
activity that occurred.

Encryption
Key
Disclosure

Accounts with encryption keys that Support Center technicians have viewed.

FileTypeSizes The fifty most frequently backed-up file extensions by size for accounts that have
been through at least one compaction cycle.

First Backup
Size

Amount of data in megabytes (MB) backed up by a group of accounts during the
first backup.

Heavy Hitters Accounts backing up themost data in MB.

Heavy Hitters Accounts with more than 20GB of data on the Data Center.
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Support
Center
report
template

Description

Last Backup A list of 8.x accounts by community, with their last backup date and status.

Restore
Activity

A list of accounts by community, and the amount of data restored by each account
during themonth to date. Restore activity includes Agent Retrieve, iRoam, and
Sharing.

Report components

To generate reports, you use the following components:

l Report template. Contains the parameters you specify to generate a report.

l Report. Contains the actual data, based on the parameters you specify in the report template.

You can include the following types of information in reports:

Report area Description

Account
information

Name and demographic information for a group of accounts. For more information
about how to create groups of accounts, see Create account groups, on page 117.

Account
summary

Status, Agent version, Agent configuration, and last backup date for a group of
accounts.

Current data
sizes

Total number and size of files stored on the Data Center for a group of accounts.

Account first
backup
sizes

Total number and size of files transferred by a group of accounts during their first
backup.

Activity
types

Number of backups, restores, and CD orders performed within a given time frame.

Create report templates

To create a new report template

1. Click theReport Templates node under the community for which you want to create a report.

If you want to, you can include subcommunities in the report.

The first Create Report Templates page opens.
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2. Select the accounts for which you want to create a report.

3. Complete the subsequent report template pages to select the information that you want to display
in the report and specify how to sort it.

4. After you create the report template, save the template on the Support Center server for reuse.

You can edit the report template any time.

Generate and view reports

After you save a report template, you can run the corresponding report at any time. You also can rerun
the report in the future. Depending on the amount of data that you need to compile the report, it can take
minutes or hours for the report to run. When the report is complete, Support Center displays the name
of the report under theReports node.

To generate and view a report

1. Log on to Support Center.

2. Select a community.

3. Expand theReports template node and select the type of report that you want to generate.

4. Click Run Report.

The Report Queue page opens.

5. Expand the reports node and select the report that you want to view.

The Report page opens. You can print the report, or download it to an XML file.

For more information, see Support Center Help.

View charts

You can include charts in reports. Support Center uses Adobe® SVGViewer to display charts. If your
computer does not have Adobe SVGViewer installed, you can download it through Support Center.
You can display a chart for the following types of information:

l Number of accounts

l Account activity values

l Total account data size values

l First backup size values

Save report results in XML

On the Reports page, you can view reports in XML format. Typically, you have to display the XML
format only when Corporate Support requests this information. After you display the XML format, you
can copy and paste the content to another file that you can send to Corporate Support.

AdministeringMac Agents
Chapter 11: Agent history and reports

Connected Backup (8.11.5) Page 116 of 125



Create account groups

You can use the reports feature to create a group of accounts and then change all of the accounts in the
group simultaneously. You can use the reports feature to change accounts in the following ways:

l Change the account status

l Change the Agent configuration

l Move the accounts to a different subcommunity

For example, you can create a report to find all accounts that have not performed a backup in the past
90 days. You can then use the list of accounts to change the status of the accounts to canceled or on
hold. The account group is a temporary entity. After you close the Support Center session, or after the
session times out, Support Center deletes the account group.

Use the Agent Protocol Session log

The Agent Protocol Session log records messages that the Agent sends and receives during backups.
Support representatives and technicians can use this log and the Data Center Protocol Session log to
troubleshoot problems that might occur when the Agent and the Data Center communicate during
backups. For example, if a problem occurs during a backup, the technician can view both Protocol
Session logs to determine whether the Agent received all messages from the Data Center, and the
reverse.

The Agent creates the Protocol Session log as a .log file and stores it the Library/Application
Support/AgentService folder in the Agent installation directory. You can view the Agent protocol
session log in a standard text editor.

Enable the Agent Protocol Session log

To enable and configure the Agent Protocol Session log, open the LogSettings.xml file. This file is in
the Library/Application Support/AgentService folder. You can configure the following
options:

Option Description

Level
Value

The verbosity of the log.

You can specify the following values:

l Info.Standard logging

l Debug.Detailed logging

l Error (default). No logging

Because the log records information only for the Info and Debug levels, use Error to
disable protocol session logging.

Log File A name for the file that the LogSettings.xml file generates.
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Option Description

Name By default, the Agent stores this file in the Log folder.

Log
Category

The type of log to which the level value applies.

You can use the LogSettings.xml file to specify logging levels for other types of logs.
Therefore, to apply the level value to the Protocol Session log, youmust specify
ProtocolLog as the Log Category.

Log
Activity
Type

How large the Agent lets the file grow.

You can specify the following values:

l FileAppender. Lets the Agent write to the log without ever purging its contents.

l RollingFileAppender (default). Limits the size of the log to a default size of 10MB
or a size that you specify.

IMPORTANT:
If you do not specify a value for Log activity type, Protocol Session logging does
not work.

The following text is an example of the LogSettings.xml file:

version=”1.0” encoding=”UTF-8”?>

TYPE log4j:configuration SYSTEM “log4j.dtd”>

j:configuration debug=”false” xmlns:log4j=”http://jakarata.apache.org/log4j/”>

<appender name=”RollingFile” class=”org.apache.log4j.RollingFileAppender”>

<param name=”File” value=”Log/Agent.log”/>

<param name=”MaxFileSize” value=”100MB”/>

<param name=”MaxBackupIndex” value=”5”/>

<layout class=”org.apache.log4j.PatternLayout”>

<param name=”ConversionPattern” value=”%d{HH:mm:ss, SSS} %5p - %m%”

</layout>

</appender>

<!-- Log everything to the console by default. -->

<root>

<logger name=”Agent.Protocol” >

<!--This value can be error (no output), info, or debug. -->

<level value=”debug” />

<appender-ref ref=”Rollingfile”/>

</logger>
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4j:configuration>
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Configurations node 18
Configurations report 114
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Send documentation feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Administering Mac Agents (Micro Focus Connected Backup 8.11.5)

Add your feedback to the email and click Send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to swpdl.ConnectedBackup.DocFeedback@microfocus.com.

We appreciate your feedback!
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